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1 About this Document 
1.1 Revision History 
 

Version Date Changes Section Pages 

1.0 31.03.2010 New document – – 

 
 

1.2 Reference Documents 
 

 
Ref. Document title Type of document Document no. 

[1] TX-I/O functions and operation User Manual CM110561 

[2] TX-I/O engineering and installation manual User Manual CM110562 

[3] Engineering workflows with XWP V4 Workflow documentation CM111001 

[4] Digital input modules Product data sheet CM2N8172 

[5] Universal modules Product data sheet CM2N8173 

[6] Super universal modules Product data sheet CM2N8174 

[7] Relay modules Product data sheet CM2N8175 

[8] Resistance measurement module Product data sheet CM2N8176 

[9] Bistable relay module Product data sheet CM2N8177 

 
 

1.3 Before you Start 
 

This document may be duplicated and distributed only with the express permission 
of Siemens, and may be passed only to authorized persons or companies with the 
required technical knowledge. 
 
These documents were prepared with great care.  
 The contents of all documents are checked at regular intervals.  
 Any corrections necessary are included in subsequent versions.  
 Documents are automatically amended as a consequence of modifications and 

corrections to the products described.  
Please make sure that you are aware of the latest document revision date.  
If you find lack of clarity while using this document, or if you have any criticisms or 
suggestions, please contact the product manager in your nearest branch office. 
The addresses of the Siemens regional companies are available at  
www.buildintechnologies.siemens.com 
 
Before using our products, it is important that you read the documents supplied 
with or ordered at the same time as the products (equipment, applications, tools 
etc.) carefully and in full. 
We assume that persons using our products and documents are authorized and 
trained appropriately and have the technical knowledge required to use our 
products as intended.  

Copyright 

Quality assurance 

Document use 
request to the reader 

http://www.buildintechnologies.siemens.com/�
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More information on the products and applications is available: 
 On the intranet (Siemens employees only) at 

https://intranet.sbt.siemens.com/SwanWeb 
 
 From the Siemens branch office near you 

www.buildintechnologies.siemens.com or from your system supplier 
 
 From the support team at headquarters fieldsupport-zug.ch.sbt@siemens.com if 

there is no local point of contact 
 
Siemens assumes no liability to the extent allowed under the law for any losses 
resulting from a failure to comply with the aforementioned points or for the improper 
compliance of the same.  
 
 

https://intranet.sbt.siemens.com/SwanWeb�
http://www.buildintechnologies.siemens.com/�
mailto:fieldsupport-zug.ch.sbt@siemens.com�
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1.4 Terminology 
 

The key terms in TX-I/O terminology are listed below.  
 

Term Definition, description 

Addressing Unit from a module number (range 1…120) and an I/O point number (ranage 1…16) from the view of 
the building automation system.  

Address key Accessory part that has to be inserted in the TX-I/O module.  

The mechanical coding of the key assigns the module its address. 

Bus connection module "Passive" module that relays the bus signal and the module supply from one I/O row to the next 
and/or feeds an additional field supply for peripheral devices (AC/DC 12...24 V) 

Bus Interface Module (BIM) Interface between a controller and the bus of the TX-I/O modules. 

Bus master Device with general functions for a group of I/O modules. 

TX-I/O module bus (island bus)  Communication bus between the bus master (bus interface module, BIM) and the connected TX-
I/O modules. 

 Also serves as carrier of the module supply and field supply. 

 The bus is constructed by plugging the TX-I/O modules together. 

Electronic unit Removable part of the TX-I/O module with the module electronics. 

Functional test Control of an output (separate island bus) – i.e., program commands are not effective.  

When disconnecting the connection of the BIM tool (or in the case of power failure), the outputs 
assume their original values again. 

I/O function Function in an I/O point that defines the point's operation mode (e.g., signal input, voltage output 
0...10 V). 

Specific functions can occupy a number of I/O points (e.g., multistage switching output). 

I/O island All TX-I/O devices (bus users) that are physically connected to the same island bus segment and 
connected by a common bus master. 

I/O module Device in which the physical signals of the field devices are converted to software process values 
and vice versa. 

An I/O module has a number of I/O points specified by the module type. The modules are divided 
into a terminal socket and a pluggable electronic unit. 

I/O point Smallest addressable unit in an I/O module. 

One or more I/O points (e.g., a three-stage switching output) correspond to one data point/channel 
on the automation station. 

I/O row An I/O island comprising different rows of modules.  

Each row starts either with a bus master, a supply module or a bus connection module. 

Terminal Connection unit for the cables of the peripheral devices (field devices). 

Terminal socket Part of the TX-I/O module that is mounted on the standardized mounting rail and on which the wiring 
is implemented.  

The terminals implement the function of switching cabinet series terminals. 

Configuring Specification of the functionality of an I/O point by defining an I/O function and its parameters.  

An I/O function that already exists in a module before the downloading and its I/O points are first 
disabled (for details, refer to the TX-I/O engineering documentation [3]). 

Local override control Operation of an output using keys on the module. 

Deletion key Used to reset the module function to the factory settings.  

Inserted in place of the address key for later removal. 

Process value Software image of the physical value in the peripheral device.  

Communicated on the bus. 

Parameterize Change the properties of an I/O function during the configuration or operation (for details, please 
refer to the TX-I/O engineering documentation [3]). 

Supply module "Active" power supply that converts AC 24 V to DC 24 V.  

Provides module power supply for operation of the module electronics and supply for field devices 
with DC 24 V and AC 24 V. 

Tool override control Control of an output using a tool. 
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2 General 
2.1 Overview 
 

Profinet BIM is an interface module which enables to access from the Simatic 
infrastructure to 
 process data 
 configuration data and 
 parameters 
 
of TX-I/O modules.  
 
 

2.2 Application 
 

The purpose of Profinet BIM is to connect the two communication media, TX-I/O 
and PROFINET-DP, and in this way to allow access to the DESIGO I/O modules 
from a SIMATIC S7. 
 
Within SIMATIC  
 Profinet BIM is handled as a Profinet I/O device and  
 TX-I/O modules are represented as Profinet I/O modules.  
 
 In the Profinet infrastructure, Profinet BIM behaves as a PNIO device and 

supports the datagram data exchange in the direction of the Profinet IO 
controller (SIMATIC S7).  

 
 On the island bus (communication bus of the TX-I/O modules) the Profinet BIM 

operates as the island bus master. Consequently, it is responsible for the data 
flow to and from the TX-I/O modules.  

 
All data forwarded via the Profinet BIM is converted to the datagram format used 
by SIMATIC S7.  

 
Engineering of the Profinet BIM is carried out using standard Profinet I/O 
engineering methods. The properties of the TX-I/O modules are saved in the 
product-specific GSDML file. The GSDML file provides the basis for engineering 
with the Profinet project engineering tool (e.g., Simatic Manager). 
 
The Profinet BIM does not require engineering. It receives its parameters from the 
Profinet I/O controller assigned to it (e.g., from the SIMATIC S7).  
 
 
 
 
 

Function 

Handling 

Behavior 

Engineering 
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2.3 Configuration 
 

The following figure shows how the TX-I/O modules are connected to SIMATIC S7 
(S7-200, 300 and 400) and to the higher-level management PC. 
 

 
 
 

2.4 Features 
 

On the Profinet side, Profinet BIM supports 100-MHz full duplex Ethernet 
communication. 
 
The performance (number of TX-I/O modules per Profinet BIM that can be used) 
depends on the following specific conditions: 
 
64 TX-I/O modules (max.) 
 
 Programmable TX-I/O module addressing range 1–120 

It is recommended to start from 1 and increase in steps.   
 Maximum of 256 input bytes made up of the following data: 

– Total of all process data bytes of all input modules 
– Number of input modules 
– Number of output modules. 

 
 Maximum of 256 output bytes made up of the following data: 

– Total of (all) process data bytes of all output modules 
 
 The cyclical input and output data of a configured Profinet BIM can be calculated 

using the following table. The number of input and output data bytes are added 
together for each connected TXM module and each channel function.  

 
 
 
 

Communication 

Performance 

Support 

Conditions 
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Device / module / 
function 

Cyclic 
input data 
length 

Cyclic 
output data 
length 

Profinet BIM device 4 0 

TXM1.8D 1 0 

TXM1.16D 2 0 

TXM1.8U 1 0 

TXM1.8U-ML 1 0 

TXM1.8X 1 0 

TXM1.8X-ML 1 0 

TXM1.6R 1 1 

TXM1.6R-M 1 1 

TXM1.6RL 0 1 

TXM1.8P 1 0 

AI_XXX 2 0 

BI_XXX 0 0 

CI 4 1 

AO_XXX 0 2 

AO_Y250T_2Cha 0 2 

BO_XXX 0 0 

MO_XXX_XXX 0 0 

 
A Profinet BIM with 
– a TXM1.8D module with  

 BI pulse configuration in channel 1 
 CI configuration in channel 2 

occupies:    
Quantity Device (input or output) Input Output 

1 x Profinet BIM device 4 0 

1 x TXM1.8D 1 0 

1 x BI 0 0 

1 x CI 4 1 

Total  9 bytes 1 byte 
 

– 9 bytes cyclic input data length and 
– 1 byte cyclic output data length  

 
In the cyclic telegram between Profinet BIM and Profinet I/O controller: 
the input and output data lengths vary according to the TX-I/O module used and 
its configured functionality.  

 
Module process data Chapter 4 
 
 
 

2.5 Cycle Times of Profinet BIM 
 

The cyclic process data exchange between Profinet and the island bus runs with 
different cycle times.  
 
Possible cyclic process data exchange intervals are: 8, 16, 32, 64, 128, 256 ms.  

The required interval is set by the user during the SIMATIC S7 hardware 
configuration.  
 

Example 

Other data 

Profinet versus island 
bus 

Profinet 
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The process data exchange interval is fixed. The process data of every TX-I/O 
module is accessed once every 500 ms.  
 

2.6 Product Overview & Functionality 
 

The Profinet BIM can be configured for the following TX-I/O modules:  
 
 8 DP DI modules  TXM1.8D  
 16 DP DI modules TXM1.16D  
 6 DP DI modules with relay  TXM1.6R  
 6 DP DO modules with relay / local override TXM1.6R-M  
 6 DP DO modules with bistable relay TXM1.6RL  
 6 DP PT100 modules TXM1.8P 
 8 DP Universal modules TXM1.8U  
 8 DP Universal modules with  

local override / identification device (LOID)  TXM1.8U-ML  
 8 DP Super Universal modules  TXM1.8X  
 8 DP Super Universal modules with LOID  TXM1.8X-ML  
 
 

DP Data point 

DI Digital Input 

DO Digital Output 

LOID Local Override, Identification 

 
 

The following pages provide an overview with signal types, S7 types, brief 
descriptions and the maximum number of functions for each module.  
 

Signal type S7 type Description 

 

Max. number of functions per module 

 

I/O
 p

o
in

ts
 

p
er

 f
u

n
ct

io
n

 

T
X

M
1.

8D
 

T
X

M
1.

16
D

 

T
X

M
1.

8U
 

T
X

M
1.

8U
-M

L
 

T
X

M
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8X
 

T
X
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T
X

M
1.

8P
 

T
X

M
1.

6R
 

T
X

M
1.

6R
-M

 

T
X

M
1.

6R
L

 

            

Digital inputs            

D20 /  D20R BI_STATIC Indication; floating permanent 
contact, NO, NC contact 

1 8 16 8 8 8 8     

D20S BI_PULSE Indication; floating pulse contact, 
NO contact 

1 8 16 8 8 8 8     

C  
 
 

CI_Limited 

CI 

CI 

Metering; floating pulse contact, 
mechanical or electronic, NO 
contact 

max. 10 Hz, with debouncing 

max. max. 25 Hz, with 
debouncing 

max. 100 Hz, electronic 

 
 
 

1 

1 

1 

 
 

8 

 

 
 

8 

 

 
 
 

 

8 

8 

 
 
 

 

8 

8 

 
 
 

 

8 

8 

 
 
 

 

8 

8 

    

            

Analog inputs            

NTC10K AI_NTC10K Temperature sensor; NTC 10 K 1   8 8 8 8     

NTC100K AI_NTC100K Temperature sensor; NTC 100 K 1   8 8 8 8     

P100 (4-Draht) AI_PT100_4 
Climatic 

Resistor;  
250 Ω / temperature Pt 100 

1       8    

P100 (4-Draht) AI_PT100_4 
Standard 

Resistor;  
250 Ω / temperature Pt 100 

1       8    

NI1K AI_NI1K Temperature sensor; LG-Ni 1   8 8 8 8 8    

Island bus 
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Signal type S7 type Description 

 

Max. number of functions per module 

 

I/O
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p
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M
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T
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T
X

M
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6R
-M

 

T
X

M
1.

6R
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1000 Ω 

R250 (2 wire) AI_R250 Resistor; 250 Ω 1       8    

R2K5 AI_R2K5 Resistor; 2500 Ω 1   8 8 8 8 8    

Pt1K375 AI_PT1K375 
Climatic 

Temperature sensor; Pt 1000, 
climatic 

1   8 8 8 8 8    

Pt1K385 AI_PT1K385 
Standard 

Temperature sensor; Pt 1000, 
standard 

1   8 8 8 8 8    

T1 AI_T1 Temperature sensor; PTC 1   8 8 8 8     

U10 AI_U10N Voltage; DC 0 .. 10 V 1   8 8 8 8     

I25 AI_I020 Current; 0...20 mA 1     4 4     

I420 AI_I420 Current; 4...20 mA 1     4 4     

            

Digital outputs             

Q250 BO_Q250 Permanent contact, switch 1        6 6  

Q250A-P /  
Q250-P  

BO_Q250P_2Cha Pulse on/off 
2        3 3  

 BO_Q250P_1Cha Pulse on/off with current surge 
relay (ElTako) 

1        6 6  

Q-M2…4 MOx_Static_xCha Pulse contact, 2-4-stage 2-4        1-3 1-3  

Q250-P2..4 MOx_Pluse_x+1Cha Pulse, 3-stage 3-5        1-2 1-2  

Q250L BO_Bistabil NO-contact, bistable 1          6 

Y250T  AO_Y250T Pulse, actuating signal, 3-point 
output, internal hub model 

2        3 3  

            

Analog outputs            

Y10S AO_U10N Constant actuating signal DC 
0…10 V 

1   8 8 8 8     

Y420 AO_I420N Constant actuating signal DC 
4…20 mA 

1     4 4     

            

Indication and local override control            

  Local override control     x  x   x  

  LCD indication     x  x     

  Green I/O status LEDs   x x x x x x x  x 

  3-color I/O status LEDs  
(varies acc. to signal type) 

 x        x  

 
 On TXM1.16D the counters are implemented on the inputs 1 to 8  
 On TXM1.8X.. the 4...20 mA outputs are implemented on the I/O points 5 to 8   
 Digital inputs are not isolated galvanically from the system electronics  
 Mechanical contacts must be free of potential  
 Electronic switches must support SELV / PELV   
 Meter inputs that count faster than 1 Hz and are longer than 10 m and in the 

same cable duct with analog inputs must be shielded. 
 
The Y250T function (actuating signal, three-point output) occupies two I/O points.  
There is room for 3 actuating drives on a TXM1.6R relay.  

Note 

Example of reading 
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3 Engineering 
 

Engineering is based on the GSDML file. It is standardized in accordance with the 
GSDML Specification for Profinet IO V2.2. 
 
The engineering tool (Simatic Manager) is part of the engineering process. It needs 
to be informed by an import about which GSDML file to use for the Profinet BIM.  
 
As a result of the import, the Profinet BIM will then appear as a field device in the 
hardware catalog of the program (path: ...\Profinet IO\I/O\TX-I/O).  
 
Engineering can be carried out in the following two different ways:  
1 a) First, the application is created and loaded into the CPU and  

b) then the periphery is configured, or  
2 a) First, the modules are configured and tested, and  

b) then the application is loaded.  
In this case, specific organization blocks (OBs) must be available. If one of 

these organization blocks is missing, then in the event of 
 configuration errors and 
 if a module fails during running operation 
the CPU will be stopped.   
The following organization modules should be available: 

 
OB no OB name Meaning 

OB82 I/O Point Fault 1  Diagnostics alarm 

OB83 I/O Point Fault 2  Removal/insertion (of modules) 

OB85 OB Not Loaded Fault  Program operation error 

OB86 Loss of Rack Fault Module rack failure 

OB122 Module Access Error Program operation error 
 

can be found in the online help function of the SIMATIC Manager 
If no organization blocks are yet available, you can find information as follows:  
 SIMATIC Manager > Help > Find tab > Organization blocks 

or 
 SIMATIC Manager > Wizard for new project > Next > Select CPU type > 

Next > mark the required OB > Help for OB button 
 

Note  
In this sequence do not click the Finish button.  

 
We assume in this manual that are beginning a project from the very start. The 
following procedure is useful: 
 
1. SIMATIC Manager Create a Step7 project  

See Section 3.1 – Create a Step7 project  
2. Import Profinet BIM GSDML file 

Current GSDML file: GSDML-V2.2-Siemens-ProfinetBim-<yyyymmdd>.xml 
Refer to Section 3.2 – Instal GSDML file: Import GSDML and BMP files  

3. Under HW Config on the programming PC: engineer S7-CPU 2xx/3xx/4xx-
2PN/DP  

The corresponding step-by-step method is given below. 

GSDML file 

SIMATIC Manager 

Workflow 

Help regarding the 
organization blocks 
(OBs) 

Procedure 
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3.1 Creating a Step7 Project 
 

1. Open the SIMATIC Manager  
2. File > New 

Opens a dialog field  
3. Dialog field: Enter the path and name of the project 

The suggested path should not be changed (convention).   
4. Close with OK 

Generates the project (example: PNBIM)  

  
5. Right-click PNBIM > context menu: Insert New Object 

Opens a dialog field  
6. Select the CPU family ( select the type of PCL used) 

The selected CPU family is added to the project (e.g., SIMATIC 300).  

  
Click the new entry. 
Hardware then appears in the right part of the window. 

 
1. Open the Hardware Design window: click Hardware > context menu: Open 

Object 
Opens the hardware configuration dialog window HW Config  

2. Hardware catalog: Select profile bar for CPU (e.g., Rack 300):   

  
a. Open the appropriate folder 
b. Doubleclick the profile bar or use drag&drop 
 to insert the profile bar in the right window section.   

  
 
1. Rightclick Rack: Field 1 > context menu: Insert Object  
2. From the list box, select a power supply 

The power supply is added to the rack. 
 

Select a CPU 

Select a rack 

Add power supply 
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1. Add a PLC CPU (e.g., CPU 317-2 PN/DP):   
2. Hardware catalog: Open up the tree to the corresponding folder   
3. Add the required version of the CPU to the rack by drag&drop. 

During this action the corresponding field of the rack changes to green.  
After dropping the CPU, the dialog field Ethernet interface properties opens.   
 

1. Ethernet interface properties dialog field, Parameters tab: 
a. Optional: Change the IP address and subnet mask 

We recommend that the suggested address be left unchanged. 
b. Subnetz group field: select the required subnet from the list box 

If no subnet is displayed, continue with 2. 
c. OK button.  

2. Subnet group field: NEW button 
Open the Properties dialog field – new subnet Industrial Ethernet  

3. Properties dialog field – new subnet Industrial Ethernet, text field Name:  
a. Enter the required subnet name 
b. OK button. 
 The subnet name then appears in the selection of the Properties dialog 

field – new subnet Industrial Ethernet.   
4. Ethernet interface properties dialog field, Parameters tab: 

a. Select subnet 
b. OK button.   

  
 

In the event of multiple selection options, an Ethernet interface must always be 
selected. 
 
The Profinet (Ethernet) interface can also be added at a later time. Proceed in this 
case as follows:  
1. Rightclick PNIO subslot   
2. List field: Add Profinet I/O system 
 

If the I/O system was already created, it is now automatically attached to 
the subsystem.  

 
Note 

If the I/O system is not already available, please proceed as described above (Add 
Profinet I/O system).  
 
 

Add a CPU 

Add Profinet I/O system 

Note  

Add Profinet interface 
later 
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3.2 Install GSDML File  
 

After installing a SIMATIC Manager 
 the GSDML file (data, xml file) and 
 the corresponding image file (icon, bmp file) 
are not available. They must be imported.  
 

Before the installation, you must copy the files to a folder outside 
C:\...\Siemens\Step7\GSD\... – otherwise they will not be installed. During the 
installation, the files are written to the above-mentioned folder.  

 
1. Locate the GSDML file and bmp files  

( this is only an example): \\Ch021090.ww020.siemens.net\TX-
IO_for_Simatic\04_Firmware\Test_Release\Firmware TXB1.PROFINET\... 

This is not the full path name. You would usually want to download the 
latest version. This version can be found under the specified path as shown in 
the adjacent figure – e.g., V0.2.17.   

2. Copy files to the following path in the local PC:  
C:\Program Files\Siemens\Step7\S7tmp 

This path must be used. The files are not permitted to be copied to the 
actual target folder. This is done automatically by the installation program 
during the installation. 

 
1. Open the hardware configuration window.  
2. Tools > Install GSD Files 

Opens Install GSD Files  

  
3. Select the required GSDML file 

The possible files are listed in the text field.  
4. Install button.  

  
5. Close button. 

The file is imported into the engineering tool. After this procedure the Profinet 
BIM appears in the hardware catalog (...\Profinet IO\I/O\TX-I/O).  

Important  

Import GSDML and 
BMP files 

Install GSDML and BMP 
files 
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6. Import Profinet BIM to the Profinet network by drag&drop of the 
TXB1.Profinet BIM.   

  
 

After releasing the mouse button, the Profinet BIM is inserted and is displayed 
in the Profinet network.  

  
Note 

When clicking the Profinet BIM, the slot allocation and I/O addresses are 
displayed in detail in the station window.  

7. Rightclick I/O bar > context menu: Object Properties 
Opens the PROFINET I/O system properties dialog field.  

8. Update time tab: mark the device > Edit button 
Opens the Edit update time/mode dialog field.  

9. Set the update time to 256 ms using the dropdown list box. 
This is a recommendation. A higher clock rate makes no sense since the 
island bus is clocked at 512 ms.   

10. Close with OK. 
 
 

3.3 Engineering the Profinet BIM with the 
SIMATIC Manager  

 

The Profinet BIM is a modular device. It supports specific TX-I/O modules and their 
corresponding channel functions.  
  
TXM1.8D TXM1.8U TXM1.8X TXM1.6R TXM1.6RL 
TXM1.16D TXM1.8U-ML TXM1.8X-ML TXM1.6R-M TXM1.8P 
 
The following sections explain the engineering procedure in terms of 
 module configuration 
 submodule configuration and 
 parameterization.  
 
 Profinet BIM supports 120 slots. TX-I/O modules can be inserted in any slot 

within this range (1...120).  

Supported TX-I/O 
modules 

Supported slots 
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 Up to 64 TX-I/O modules can be connected with a Profinet BIM at the same 
time.  

3.3.1 Module Configuration 
 

The TX-I/O modules supported by the Profinet BIM are found in the hardware 
catalog under the TXB1.Profinet submodule.   
 
Please observe the following points when working on the module configuration: 
 
 Recommendation: Keep the addresses identical with the parameterized 

SIMATIC input and output addresses.   
 ---> TX-I/O module addresses must agree with the number of the slot in which 

they are located and  
---> TX-I/O modules must be inserted in the slot whose number matches 
the corresponding TX-I/O module address.  

 Slots suitable for accepting TX-I/O modules are marked in green.   
 A TX-I/O module can be deleted at any time with the Del button. In doing so, you 

must reply to a security prompt (example for a TXM1.6R module): 
 

 
 
1. Upper window section: click the required submodule 

Opens the TX-I/O module in the lower window section.  
2. Hardware catalog: insert the required TX-I/O module by drag&drop. 

When dragging the object, the free slots are displayed in green. After 
dropping the module, a window similar to the one shown below appears 
(extract, with TXM1.6R as an example).  

  
3. Save 

We recommend saving at meaningful intervals, but always for each 
inserted TX-I/O module.  
 

 

Before you start  

Procedure 
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3.3.2 Channel Configuration 
 

The functionality of the channels of the TX-I/O modules is 
mapped to the input/output submodules. The supported 
submodules (2) are listed in the hardware catalog under 
each TX-I/O module (1).  
 
Submodules can be inserted in any free subslot (free subslots are marked in 
green).   

  
Subslot 1 of the modules is defined at the factory with an object that is typical for 
the corresponding module. The subslot contains 
 the binary I/O process data of the configured binary I/O channels and 
 the override information of configured output channels.  
 
Module channels begin with subslot number 2 for the first I/O channel and end with 
the subslot number of the maximum number of module channels + 1.                                            
 
Multistate output channels (MO) must be carefully connected.  
 The channels must be integrated in precisely the order in which they appear in 

the catalog.  
 

  
1. Hardware catalog: open the module with the affected objects  
2. Enter the required objects in the TX-I/O module in the rack in the correct 

order by drag&drop. 
This only works with individual objects – multiselection is not possible.   

3. Save 
 
 

3.3.3 Parameterizing Submodules 
 

The functions with subslots of connected TX-I/O modules can be parameterized in 
the corresponding properties dialog box. The dialog box is opened by 
doubleclicking on the submodule.  
 
Parameterized values are transferred to the controller during loading of the project. 
The controller sends the parameter values to the Profinet BIM only during the 
Profinet communication start. After communication has started, the channel 

Mapping 

Free subslots 

Subslot 1  

Numbering of the 
module channels 

Multistate   
output channels  

Procedure 

Properties 
dialog box 
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parameters can only be changed by reloading the Step7 project. In doing so, the 
Profinet communication is aborted and must be restarted by the controller.  
 

  
The configurable parameters differ according to the object. A description of all 
possible parameters would exceed the scope of this documentation – for information, 
please go to 4 – Parameters, page 24 pp. for a summary.  
 
1. Rightclick the row with the required object  
2. Context menu: Object Properties > Parameters tab  
3. Edit the required parameter or parameters 

The parameters are edited 
 in a dropdown list box by selecting a value 
 in a text box by manual input 
 by selecting/unselecting a checkbox 

4. OK button. 
 
 

3.3.4 Symbol Table 
 

Symbol = user designation of an input or output address. 
Symbols are defined and remarked upon in the symbol table (address, address 
type). The symbols can then be entered in the variable table which then appear in 
the allocated symbol table in the variable table.   
 
Operand Description Format Example 

E Input bit BOOL E      8.6 

A Output bit BOOL A     30.1 

EB Input byte BIN EB    10 

AB Output byte HEX AB    11 

EW Input word DEC EW   100 

AW Output word DEC AW   120 

PEW Process input word DEC PEW 1000 

PAW Process output word DEC PAW 1020 

ED Input FLOATING 
POINT 

ED     20 

AD Output FLOATING 
POINT 

AD     30 

PED Process input DEC PED 1500 

PAD Process output DEC PAD 1600 
 
1. SIMATIC Manager, left screen section: S7 Program(x) > menu: Insert > 

Symbol table 
Opens a symbol table; currently the corresponding symbol is visible on the 

right of the screen:    
2. Optional: Rename the symbol (Edit > Rename > Text box: Enter new name)  
3. Open the symbol table (rightclick on symbol > context menu: Open object) 

Opens the symbol editor 

Configurable 
parameters of a binary 
output channel 

Important  

Procedure 

Definition, addition 

Syntax 

Step-by-step procedure 



22 / 94  

Siemens TX-I/O PROFINET BIM V1.0 CM110564en_02 
Building Technologies Engineering 23.09.2010 

4. Symbol text box: Enter the symbol name 
Recommendation: select short, concise, meaningful names (useful for 

input into the variable table)   
5. Address text box: enter the address in the appropriate syntax  

See the Syntax table further below 
The entry of the address (column: example) is not critical in terms of the 

writing style – for example, E8.6 can be entered, but so can also E<space>8.6  
6. Address text box: exit the box (click with the mouse cursor anywhere else)  

The box on the right ("Data type" column) is automatically filled in, but can 
be adjusted manually.  

7. Save (menu Table > Save)  
8. a. Table > Close (after entering the desired data points) 

If the table was not saved beforehand, a security prompt is issued here.  
b. Reply to the security prompt as appropriate. 

 
After exiting a box, different error indications are possible – for example, in the 

Status column. The indications disappear when the corresponding errors are 
corrected. Example of the Status column: 
 
Symbol Cause Correction 

 Two identical symbol names available Change one of the symbol names 

 Symbol name or address missing Enter the corresponding parameter 

 
 

3.3.5 Variable Table 

3.3.5.1 Creating a Variable Table 
 

Block for displaying or editing the attributes of the current module.  
System attributes and user-defined attributes control and coordinate functions 
between individual application for reading/writing controller input, output and local 
data. All I/O address data entered in this table can be monitored and/or edited. 
 
 In order that the variable table can be created and used, specific requirements 

must be fulfilled:Defined device name in TX-I/O BIM 
 If you want to work with symbols, they must previously have been created in the 

symbol table 
 
Operand Description Format Example  

E Input bit BOOL E      8.6  

A Output bit BOOL A     30.1  

EB Input byte BIN EB    10  

AB Output byte HEX AB    11  

EW Input word DEC EW   100  

AW Output word DEC AW   120  

PEW Process input word DEC PEW 1000  

PAW Process output word DEC PAW 1020  

ED Input FLOATING 
POINT 

ED     20  

AD Output FLOATING 
POINT 

AD     30  

PED Process input DEC PED 1500  

PAD Process output DEC PAD 1600  

Note 
The values must 
be entered without 
blanks (etc.) 
between the 
operand and 
value (unlike the 
symbol table).  

1. SIMATIC Manager, left screen section: Blocks > menu: Insert > S7 block 
Insert new object > subcontext menu: Variable table.  

Error indications 

Definition, addition 

Requirements 

Syntax 

Step-by-step procedure 
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Opens the Variable table properties dialog box  
2. Variable table properties dialog box, General tab – part 1, Symbolic name text 

box: Enter name  
This name is displayed in the Simatic Manager  

3. Optional: Symbol comments text box: Enter comment   
4. General tab – part 2: fill in the text boxes as required 

Convention: The boxes Name (Header), Family and Author are allowed to 
have up to eight (8) alphanumeric characters, and Version five (5).  

5. Attributes tab: enter attributes as required  
6. OK button. 

Closes the dialog box.  
7. Optional: Table > Close (close variable table) 
  
 

3.3.5.2 Working with the Variable Table 
 

Channel values can be changed with the variable table. This is particularly useful 
when testing, during commissioning and/or for diagnostics. 
 
 The corresponding module and/or channel is released for local override  
 The SIMATIC Manager can work in online mode (S300 is available and 

operable)  
 
The symbol bar contains the elements for controlling variables using the variable 
table. When moving the mouse over a symbol ("mouseover"), the explanations/tips 
given in the table below appear. 
 

 
 
Symbol Meaning  Symbol Meaning  

 
Always in the Foreground  

 
Row not effective 

 
New  

 
Set up Connection to Configured CPU 

 
Open  

 
Set up Connection to Directly Connected 
CPU 

 
Save  

 
Help 

 
Print  

 
Variable Trigger 

 
Cut  

 
Monitor Variable  

 
Copy  

 
Modify Variable 

 
Paste  

 
Update Monitor Values 

 
Undo  

 
Activate modify values 

 
Redo  

 
Modify/Force Value as Comment (on/off) 

1. SIMATIC Manager: open tree to Blocks >  Mark blocks >   rightclick 
variable table > context menu: Open object   

General tab –  
part 1 

General tab –  
part 2 

Requirements 

Symbol bar 

Step-by-step procedure 
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Opens the dialog box Var [<name of the variable table>]  

2. Target system > Create link to > Engineered CPU 
(or Directly connected CPU or Accessible CPU) 

The corresponding link can also be established using the symbols (without 
Accessible CPU).  

3. Control value column: enter the required value as appropriate  
 

  
4. Activate the value with the Control value button  
5. Query the status value with the Update status value button  
6. Save and/or close the table as required 

When closing the table a security prompt must be answered accordingly (if 
changes were made). 

 
Note 

1. The submodule process data can be accessed by means of the E and A 
addresses using controllers and VATs (variable tables) of the SIMATIC 
Manager.  These addresses must be defined beforehand.  

 

  
2. Only variables from the process image can be viewed.  
3. The size of the process image is configured with the properties of the CPU 

under the "Cycle/clock marker" tab (separately for inputs and outputs). 
 

4 Parameters 
 

This is a summary. Its purpose is to quickly locate the relevant parameters.  

   

  

Note  
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4.1 Binary Input (Static) 
 

BI_STATIC (SIMATIC Manager hardware catalog) 
 
Static binary input = input for detecting/processing static status changes in applied 
signals.  
A floating contact is connected with the static binary input. The object carries out a 
cyclical check at the input. Every change from one stable status to the other is 
detected.  
 
 

4.1.1 Contact 
 

Parameters for defining the contact type. 
 
Possible values Description 

NO Contact "Not Open" contact 

NC Contact "Not Closed" contact 

 
Status NO contact NC contact 

Contact position LED 
indication 

Process 
value 

LED 
indication 

Process 
value 

Closed LED on 1 LED off 0 

Open LED off 0 LED on 1 

 
 

4.1.2 Debounce Time 
 

Parameter to define the minimum time that the input signal must remain stable in 
order to be valid.  

Changing the parameter resets an active debounce timer. 
 
Value range Unit 

0..255 0.1 s 

 
 

4.1.3 Display 
 

Parameters for color definition of the meaning of an indication.  
As a result, a specific LED color is assigned to each meaning.  
Parameter type: [DisplayEnum] 
 
Possible values Description 

Normal LED is lit green    

Alarm LED is lit red 

Service  LED is lit yellow 

 
Note 

 This parameter is used to assign a LED color to a signal type. After the 
configuration, the color remains permanently assigned.  

Representation 

Definition, addition 

Definition, addition 

Parameters 

Functional overview 

Definition, addition 

Parameter 

Definition, addition 

Mapping for  
multicolored LEDs 
Only modules TXM1.8D 
and TXM1.6R-M 
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It is expressly not intended for use in combination with the status of the process 
value.   

 

4.1.4 Process Data 
 

For process data mapping of binary input functions to channel process data, refer 
to the corresponding sections in Chapter 4, "Process Data Channel Mapping" of 
the TX-I/O modules.  
 
 

4.1.5 Channel Diagnosis 
 

Alarm type Cause / solution 

Invalid Check the module configuration and parameterization 
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4.2 Binary Input (Pulse) 
 

BI_PULSE (SIMATIC Manager hardware catalog) 
 
Pulse binary input = input for detecting/processing continuous status changes in 
applied signals.  
A floating contact or electronic switch is connected with the binary pulse input. The 
object carries out a cyclical check at the input. Every change from one stable status 
to the other is detected.  
 
Note 

If the Profinet communication is missing, a short pulse is indicated with the 
relevant LED for each pulse at the input.  
 

 
 
 

4.2.1 Pulse Length 
 

Parameter for defining the pulse length.  
 
Value range Unit 

0..255 0.1 s 

 
 

4.2.2 Contact 
 

Parameters for defining the contact type.  
 
Possible values Description 

NO Contact "Not Open" contact 

NC Contact "Not Closed" contact 

 
Status NO contact NC contact 

Contact position LED 
indication 

Process 
value 

LED 
indication 

Process 
value 

Contact closed > 
open 

Pulse 

0 > 1 > 0  

Pulse 

0 > 1 > 0 

0 0 

Contact open > 
closed 

0 0 Pulse 

0 > 1 > 0 

Pulse 

0 > 1 > 0 

 
 
 

Representation 

Definition, addition 

Definition, addition 

Parameter 

Definition, addition 

Parameters 

Functional overview 
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4.2.3 Debounce Time 
 

Parameter to define the minimum time that the input signal must remain stable in 
order to be valid.  

Changing the parameter resets an active debounce timer. 
 
Value range Unit 

0..255 0.1 s 

 
 

4.2.4 Display 
 

Parameters for color definition of the meaning of an indication.  
As a result, a specific LED color is assigned to each meaning.  
Parameter type: [DisplayEnum] 
  
Possible values Description 

Normal LED is lit green    

Alarm LED is lit red 

Service  LED is lit yellow 

 
Note 

This parameter is used to assign a LED color to a signal type. After the 
configuration, the color remains permanently assigned.  
It is expressly not intended for use in combination with the status of the process 
value.  
 
 

4.2.5 Process Data 
 

For process data mapping of binary input functions to channel process data, refer 
to the corresponding sections in Chapter 4, "Process Data Channel Mapping" of 
the TX-I/O modules. 
 
 

4.2.6 Channel Diagnosis 
 

Alarm type Cause / solution 

Invalid Check the module configuration and parameterization 

 
 

Definition, addition 

Parameter 

Definition, addition 

Mapping for  
multicolored LEDs 
Only modules TXM1.8D 
and TXM1.6R-M 
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4.3 Counter Input 
 

CI_PULSE (SIMATIC Manager hardware catalog) 
 
Parameters for counting floating pulses. 
The counter value is provided as a process value. 
 
 

4.3.1 Contact 
 

Defines the contact type. 
 
Possible values Description 

Mechanical Contact Mechanical contact 

Electrical Contact Electrical contact 
 
 The counter rises in increments when the contact closes ( 0 RR ).  
 The debounce time for the signal type [Contact_Mech] is long, but short for 

[Contact_El].  
Note the following: a short debounce time allows higher signal frequencies that 
can be counted, but at the same time demands greater signal quality of the 
contact.  
 

Reference values for sampling rates of 1 (50 %).  
Contact type fmax [Hz] 

Contact_Mech  25     

Contact_El  100     

 
 

4.3.2 New CI Value 
 

New counter value that is set by the controller during the connection setup phase 
of the Profinet communication. 
The existing counter value is replaced by the new counter value if the function 
output byte value changes from 0 to 1.  
 
Value range 

0...232-1  (= 4294967295) 

 
 

4.3.3 Power-up Mode 
 

Parameters for defining the behavior of [PowerUpMode]. 
The operation of the counter after powering up the I/O module can be configured in 
two possible modes with the [PowerUpMode] parameter: 
 Normal mode (RESET) 
 Safe mode (LASTVALUE) 
 
After powering up the I/O module, the counter is reset to "0" (default value) – the 
counter value does not have to be permanently saved in the I/O module.   
The controller is responsible for the following: 
 for tracing the current counter and 
 for persistent saving in the event of power failure.  

Representation 

Definition, addition 

Definition, addition 

Parameters 

Definition, addition 

Parameter 

Definition, addition 

Normal mode (RESET) 
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If the communication between the I/O module and controller is interrupted, and 

the I/O module detects this as a power supply fault, the pulses accumulated during 
the downtime are not considered.  
 
After powering up the I/O module, the counter is reset to the last persistently saved 
value before the power supply fault occurred. The controller traces the current 
counter value for as long as the communication works between the I/O module and 
controller. If the communication is interrupted, the I/O module must continue to 
trace the value and prevent loss of the counter value in the I/O module that 
threatens to happen in the case of a power supply fault. Once the communication 
has returned to normal operation, the current counter value is relayed to the 
controller.  
 

Note 
 The prevention of loss of the counter value is a local task for the I/O module. 

Security can be obtained in the following ways: 
– by saving the counter value upon detection of a power supply fault, and/or 
– by periodic saving of the counter value, and/or 
– by any other mechanism.  

 
 Because of the limited number of write cycles of the volatile memory and for 

economic reasons, the counter value may not be absolutely accurate.  
 
 

4.3.4 Process Data 
 

For process data mapping of counter input-configured channels, refer to the 
corresponding sections in Chapter 5, "Process Data Channel Mapping" of the TX-
I/O modules. 
 
 

4.3.5 Defining Start Counter Value 
 

The start counter value is defined in the SIMATIC Manager module parameter 
window. It is transferred to the Profinet BIM during the connection setup phase. 
The transmitted counter value is activated when the corresponding channel bit 
changes from '0' to '1'.  
 
For counter value mapping of counter input (CI)-configured channels, refer to the 
corresponding sections in Chapter 5, "Counter Value Definition Channel Mapping" 
of the CI-configured TX-I/O modules. 
 
 

4.3.6 Channel Diagnosis 
 

Alarm type Cause / solution 

Invalid Check the module configuration and parameterization 

 

Safe mode 
(LASTVALUE) 
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4.4 Binary Output – OnOff 
 

BO_Q250 (SIMATIC Manager hardware catalog)  
 
Unit for converting a binary process value to the module-specific switching value.  
 
 

4.4.1 Backup Mode 
 

Function for control of the behavior of the function when changing to the 
"MasterDown" status. 
 
Possible values Description 

NO Process value = INACTIVE, 0 (Off) 

VALUE Specific value of the parameter [BOBackupValue] 

KEEP Save the last active process value 

 
 

4.4.2 BO Backup Value 
 

Parameter – type [BinaryValueEnum] – that represents the backup value and 
becomes valid in the following cases:  
 a change in status to "MasterDown" and 
 the parameter [BackupMode] = VALUE 
 
Possible values Description 

ACTIVE Binary output is active. 

INACTIVE Binary output is inactive. 

 
 

4.4.3 Display 
 

Parameters for color definition of the meaning of an indication.  
As a result, a specific LED color is assigned to each meaning.  
Parameter type: [DisplayEnum] 
 
Possible values Description 

Normal LED is lit green    

Alarm LED is lit red 

Service  LED is lit yellow 
 

Note 
 This parameter is used to assign a LED color to a signal type. After the 

configuration, the color remains permanently assigned.  
It is expressly not intended for use in combination with the status of the process 
value.  

 
 

Representation 

Definition, addition 

Definition, addition 

Definition, addition 

Definition, addition 

Mapping for  
multicolored LEDs 
Only modules TXM1.8D 
and TXM1.6R-M 
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4.4.4 Enabling Local Override 
 

Parameter for enabling/disabling the module key Up/Down for the "Local override" 
function.  
 
The general switching behavior (for enabled local overriding) is defined as follows: 
 Switch from automatic to local override (manual): 

The current process value is valid until a new manual command is issued.  
 Switch from local override to automatic: 

The automatic process value becomes valid once the Profinet I/O controller 
writes a new value.  

 
Possible values Description 

Selected Enabled 

Not selected Disabled 

 
 

4.4.5 Local Override Mode 
 

Parameter for defining the type of 'local override' signal. 
A logical '1' is usually interpreted as 'active'. However, it is possible for migrations 
to interpret a logical '0' as 'active'. 
 
The following assignments apply here: 
 
Value Input Local override 

Active 1 Active 

Inactive 0 Active 

Active 0 Inactive 

Inactive 1 Inactive 

 
 

4.4.6 Process Data 
 

BO value LED NO contact NC contact 

Active On Closed Open 

Inactive Off Open Closed 
 
The allocation of process data of binary output-configured channels is described in 
'Process Data Channel Mapping' for the corresponding TX-I/O module.  
 
If the TX-I/O BIM is in the status 'Masterdown', a backup value becomes valid 
according to [BackupMode]. 
 
 

4.4.7 Channel Diagnosis 
 

Alarm type Cause / solution 

Invalid Check the module configuration and parameterization 

No_Output Operating voltage too low -> check the power 

 

Definition, addition 

Switching behavior 

Definition, addition 

Masterdown 
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4.5 Binary Output (Bistable) 
 

BO_BISTABIL (SIMATIC Manager Hardware catalog)  
 
Parameter for converting a binary process value to the module-specific switching 
value.  
Unlike the OnOff binary output function, the following points apply to this output: 
 The behavior can be defined if PowerDown (AC) is detected. In this regard, 

bistable relays are used that retain their status during PowerDown.  
 The activation of the backup value can be delayed if a MasterDown status is 

detected.  
 
 

4.5.1 Backup Mode 
 

Function for control of the behavior of the function when changing to the 
"MasterDown" status. 
 
Possible values Description 

NO Process value = INACTIVE, 0 (Off) 

VALUE Specific value of the parameter [BOBackupValue] 

KEEP Save the last active process value 

 
 

4.5.2 BO Backup Value 
 

Parameter – type [BinaryValueEnum] – that represents the backup value and 
becomes valid in the following cases:  
 a change in status to "MasterDown" and 
 the parameter [BackupMode] = VALUE 
 
Possible values Description 

ACTIVE Binary output is active. 

INACTIVE Binary output is inactive. 

 
 

4.5.3 BackupDelay 
 

Parameter for defining a delay upon activation of a backup value (according to the 
[BackupMode]) after detection of a MasterDown.  
 
Value range Unit 

0...65535 0.1 s 

 
 

4.5.4 PowerDownModeAC24V 
 

Parameter for defining the behavior following the detection of a MasterDown.  
 
Possible values Description 

NO Process value = INACTIVE, 0 (Off) 

VALUE Specific value of the parameter [BOBackupValue] 

KEEP Save the last active process value 

 

Representation 

Definition, addition 

Definition, addition 

Definition, addition 

Definition, addition 

Definition, addition 
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4.5.5 BOPowerDownValue 
 

Parameter for representation of the backup value that becomes valid when 
 the device takes on the status PowerDown and 
 the parameter [PowerDownModeAC24] = VALUE. 
 
Possible values  

INACTIVE  

ACTIVE  

 
 

4.5.6 Display 
 

Defines the meaning of the display color.  
As a result, a specific LED color is assigned to each meaning.  
Parameter type: [DisplayEnum] 
 
Possible values Description 

Normal LED is lit green    

Alarm LED is lit red 

Service  LED is lit yellow 
 

Note 
 This parameter is used to assign a LED color to a signal type. After the 

configuration, the color remains permanently assigned.  
It is expressly not intended for use in combination with the status of the process 
value.  

 
 
4.5.7 Enabling Local Override 
 

Enable/disable the module key Up/Down for the "Local override" function.  
 
The general switching behavior (for enabled local overriding) is defined as follows: 
 Switch from automatic to local override (manual): 

The current process value is valid until a new manual command is issued.  
 Switch from local override to automatic: 

The automatic process value becomes valid once the Profinet I/O controller 
writes a new value.  

 
Possible values Description 

Selected Enabled 

Not selected Disabled 

 
The module TXM1.6RL ('light module') does not support local overriding. 

Definition, addition 

Definition, addition 

Mapping for multicolor 
LEDs 
Only module TXM1.8D 

Definition, addition 

Switching behavior 

Restriction  
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4.5.8 Local Override Mode 
 

Parameter for defining the type of 'local override' signal. 
A logical '1' is usually interpreted as 'active'. However, it is possible for migrations 
to interpret a logical '0' as 'active'. 
 
The following assignments apply here: 
 
Value Input Local override 

Active 1 Active 

Inactive 0 Active 

Active 0 Inactive 

Inactive 1 Inactive 

 
 

4.5.9 Process Data 
 

BO value LED NO contact NC contact 

Active On Closed Open 

Inactive Off Open Closed 
 
The allocation of process data of binary output-configured channels is described in 
'Process Data Channel Mapping' for the corresponding TX-I/O module.  
 
If the TX-I/O BIM is in the status 'Masterdown', a backup value becomes valid 
according to [BackupMode] after the [BOBackupDelay] delay. 
 
If the device detects a [PowerDown], a backup value becomes valid according to 
[PowerDownModeAC24]. 
 
 

4.5.10 Channel Diagnosis 
 

Alarm type Cause / solution 

Invalid Check the module configuration and parameterization 

No_Output Operating voltage too low -> check the power 

Unreliable ACDC24V ACDC 24 V power not available > check the ACDC 24 V 
power supply 

 
 

Definition, addition 

Masterdown 

Powerdown (AC24) 
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4.6 Binary Output – OnOff Pulse (1-channel) 
 

BO_Q250_P (SIMATIC Manager hardware catalog)  
 
Parameters for control (1-channel) of a binary output with specified pulse length.  
When the process value [BOValue] is written, the output is activated for the 
specified pulse length and then deactivated again.  
If the next process value is written before the pulse expires, the pulse will be 
terminated. After a delay of [BreakTime] the next pulse is generated.  
The minimum duration between two process value write operations is specified by 
the cycle time of the PNIO controller.  
 
S7 software 
The S7 software outputs a pulse output signal if the status of a field device is to 
change from 0 to 1 or from 1 to 0.  
 
Panel wiring 
The field device is controlled by an external surge current relay.  
 
Manual operation 
The TXM1.6R-M module allows local override by 
means of pressure on the rocker switch of one of the 
two channels. The following applies: pressure on… 
 ... Middle (hand): local override ON / OFF; no 

change at the output. The yellow LED of the channel 
lights while the override function is switched on 

 ... + (up) or  – (down): independently of the selected key, each application of 
pressure changes the status of the field device – for 
example, on – off – on – off, etc. 

 
 

4.6.1 Break Time 
 

Parameter for defining the minimum time between an 'open' and 'close' signal.  
This time is needed to prevent (electrical) damage to an actuator.  
 
Value range Unit 

0…255 0.1 s 

 
 

4.6.2 Pulse Time 
  

Parameter for defining the pulse length.  
 
Value range Unit 

1…255 0.1 s 

 
 

Representation 

Definition, addition 

Function of 

Definition, addition 

Definition, addition 
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4.6.3 Enabling Local Override 
 

Parameter for enabling/disabling the module key Up/Down for the 'Local override' 
function.  
 
The general switching behavior (for enabled local overriding) is defined as follows: 
 Switch from automatic to local override (manual): 

The current process value is valid until a new manual command is issued.  
 Switch from local override to automatic: 

The automatic process value becomes valid once the Profinet I/O controller 
writes a new value.  

 
Possible values Description 

Selected Enabled 

Not selected Disabled 

 
 

4.6.4 Local Override Mode 
 

Parameter for defining the type of 'local override' signal. 
A logical '1' is usually interpreted as 'active'. However, it is possible for migrations 
to interpret a logical '0' as 'active'. 
 
The following assignments apply here: 
 
Value Input Local override 

Active 1 Active 

Inactive 0 Active 

Active 0 Inactive 

Inactive 1 Inactive 

 
 

4.6.5 Process Data 
 

The allocation of process data of binary output-configured channels is described in 
'Process Data Channel Mapping' for the corresponding TX-I/O module.  
 
If the TX-I/O BIM has the status 'Masterdown', the relay (after a delay for an active 
pulse) will return to its original status (i.e., no new output pulse is generated).  
 
If local override is active after starting the TX-I/O, no output pulse is generated 
either.  
 
 

4.6.6 Channel Diagnosis 
 

Alarm type Cause / solution 

Invalid Check the module configuration and parameterization 

No_Output Operating voltage too low -> check the power 
 
 
 

Definition, addition 

Switching behavior 

Definition, addition 

Masterdown 

Local override 
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4.7 Binary Output – OnOff Pulse (2-channel) 
 

BO_Q250_P_2CHA (SIMATIC Manager hardware catalog)  
 
Parameters for control of a binary output (2-channel) with specified pulse length.  
 
 When the process value [BOValue] changes from inactive to active, the output 

(n+1) is activated for the specified pulse length and then deactivated again.   
 When the process value [BOValue] changes from active to inactive, the output 

(n) is activated for the specified pulse length and then deactivated again.  
 If the process value [BOValue] changes while a pulse is being generated, the 

pulse will be  
– cancelled and 
– the other output is activated after a delay [BreakTime] in accordance with the 

new process value.  
 
 The S7 software provides a continuous output signal for the first channel, which 

displays the status of the field device.  
 The S7 software does not send any pulse signals since the pulses are 

generated by the TX-I/O module.  
 Each signal sent to the second channel is ignored.  
 
Locking in the module makes it impossible to run a command on both channels at 
the same time. However, we recommend the installation of an additional lock in the 
switching cabinet. The switching contacts can be used for this purpose, for 
example.  
 
The TXM1.6R-M module enables local override. Press 
the rocker switch of either of the two channels. The 
following applies: pressure on… 
 ... middle (hand): local override ON / OFF; no change at the output. The 

yellow LED of the channel lights while the override function is switched on 
 ... +  (up):  connected device on 
 ... –  (down): connected device off 
 
Possible values Description 

selected Enabled 

not selected Disabled 

 
 

4.7.1 Break Time 
 

Parameter for defining the minimum time between an 'open' and 'close' signal.  
This time is needed to prevent (electrical) damage to an actuator.  
 
Value range Unit 

0...255 0.1 s 

 
 

Representation 

Definition, addition 

Function 

S7 software 

Panel wiring 

Manual operation 

Definition, addition 
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4.7.2 Pulse Time 
  

Parameter for defining the pulse length.  
 
Value range Unit 

1...255 0.1 s 

 
 

4.7.3 Enabling Local Override 
 

Parameter for enabling/disabling the module key Up/Down for the 'Local override' 
function.  
 
General switching behavior (for enabled local overriding): 
 Switch from automatic to local override (manual): 

The current process value is valid until a new manual command is issued.  
 Switch from local override to automatic: 

The automatic process value becomes valid once the Profinet I/O controller 
writes a new value.  

 
Possible values Description 

Selected Enabled 

Not selected Disabled 

 
 

4.7.4 Local Override Mode 
 

Parameter for defining the type of 'local override' signal. 
A logical '1' is usually output for 'active'. However, it is possible for migrations to 
output a logical '1' for 'active'. 
 
The following assignments apply here: 
 
Value Input Local override 

Active 1 Active 

Inactive 0 Active 

Active 0 Inactive 

Inactive 1 Inactive 

 
 

4.7.5 Process Data 
 

The allocation of process data of binary output-configured channels is described in 
'Process Data Channel Mapping' for the corresponding TX-I/O module.  
 
If the TX-I/O BIM has the status 'Masterdown', the relays (after a delay for an active 
pulse) will return to their original status (i.e., no new output pulse is generated).  
 
If local override is active after starting the TX-I/O, an output pulse defined by 
[BOValue] will be generated.  
 
 

Definition, addition 

Definition, addition 

Switching behavior 

Definition, addition 

Masterdown 

Local override 
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4.7.6 Channel Diagnosis 
 

Alarm type Cause / solution 

Invalid Check the module configuration and parameterization 

No_Output Operating voltage too low -> check the power 
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4.8 Multistate Output Mapping (Static) 
 

MO(X)_STATIC_(X)CHA_(X) (SIMATIC Manager hardware catalog)  
 
Parameter for mapping the multistate process value to a specific number of output 
channels. 
 
We distinguish between three different [MO(n)_Static] function types. The following 
table shows the channels in regard to function and representation in the SIMATIC 
Manager hardware catalog: 
 
Channels Relevant submodules,  

representation in the Simatic Manager hardware catalog  

2-channel MO2_Static_2Cha_St1 

MO2_Static_2Cha_St2 

3-channel MO3_Static_3Cha_St1 

MO3_Static_3Cha_St2 

MO3_Static_3Cha_St3 

4-channel MO4_Static_4Cha_St1 

MO4_Static_4Cha_St2 

MO4_Static_4Cha_St3 

MO4_Static_4Cha_St4 
 

Important 
These function groups must be inserted in the subslots 
 without any changes to the order and 
 in direct succession to each other. 
 
 

4.8.1 Mapping Function 1:n 
 

Parameter for mapping the multistate process 
value to a single active output channel in 
accordance with the parameter [MappingTable].  
 

Only a single output can ever be active.  
In the case of an invalid [MOValue] (i.e., no 
corresponding value was found in 
[MappingTable], 
 a quality error message (Reliability) is 

generated [Quality = MULTISTATE_FAULT]  
 a backup value becomes valid according to the 

value in [BackupMode].  
 

Duplicate assignments in the [MappingTable] 
are not detected by the I/O function. Only the 
value that is found first determines the output 
channel.  

 

 
 

Representation 

Definition, addition 

Function and 
representation of the 
channels 

Definition, addition 
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4.8.2 The Mapping Function UpDown 
 

Parameter for assigning a [MOValue] to 
multistate outputs. 
The parameter enables multiple outputs at the 
same time. Their combination is fixed (and 
remains so).   

 

 
 

4.8.3 The Mapping Function BINARY 
 

Parameter for assigning a [MOValue] to 
multistate switching outputs. 
 
The parameter enables multiple outputs at the 
same time. Their combination is fixed (and 
remains so).   

 

 
 

4.8.4 Backup Mode 
 

Function for control of the behavior of the function when changing to the 
"MasterDown" status. 
 
Possible values Description 

NO Process value = INACTIVE, 0 (Off) 

VALUE Specific value of the parameter [BOBackupValue] 

KEEP Save the last active process value 

Definition, addition 

Definition, addition 

Definition, addition 
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4.8.5 MO Backup Value 
 

Parameter – type [BinaryValueEnum] – that represents the backup value and 
becomes valid in the following cases:  
 a change in status to "MasterDown" and 
 the parameter [BackupMode] = VALUE 
 
Possible values Description 

ACTIVE Binary output is active. 

INACTIVE Binary output is inactive. 
 
Backup values are the same values as the process data values for the channels. 
For information, refer to 'Process Data Channel Mapping' of each TX-I/O module 
with MO function.  
 
 

4.8.6 Mapping Type 
 

Parameter for defining the mapping type.  
 
Possible values Description 

Mapping_1_n 1:n mapping 

MappingUpDown UpDown mapping 

MappingBinary Binary mapping 

 
 

4.8.7 Enabling Local Override 
 

Parameter for enabling/disabling the module key Up/Down for the 'Local override' 
function.  
 
General switching behavior (for enabled local overriding): 
 Switch from automatic to local override (manual): 

The current process value is valid until a new manual command is issued.  
 Switch from local override to automatic: 

The automatic process value becomes valid once the Profinet I/O controller 
writes a new value.  

 
Possible values Description 

Selected Enabled 

Not selected Disabled 

 
 

4.8.8 Local Override Mode 
 

Parameter for defining the type of 'local override' signal. 
A logical '1' is usually interpreted as 'active'. However, it is possible for migrations 
to interpret a logical '0' as 'active'. 
 
The following assignments apply here: 
 
Value Input Local override 

Active 1 Active 

Inactive 0 Active 

Active 0 Inactive 

Inactive 1 Inactive 

Definition, addition 

Definition, addition 

Definition, addition 

Switching behavior 

Definition, addition 



44 / 94  

Siemens TX-I/O PROFINET BIM V1.0 CM110564en_02 
Building Technologies Parameters 23.09.2010 

4.8.9 Process Data 
 

The allocation of process data and the channel status information of multistate 
output-configured channels for local override are described in 'Process Data 
Channel Mapping' for the corresponding TX-I/O module.   
 
Mapping type S7 representation MOValue value range 

1:n mapping MO2_Static_2Cha 

MO3_Static_3Cha 

MO4_Static_4Cha 

0,1,2 

0, 1, 2, 4 

0, 1, 2, 4, 8 

UpDown mapping MO2_Static_2Cha 

MO3_Static_3Cha 

MO4_Static_4Cha 

0, 1, 3 

0, 1, 3, 7 

0, 1, 3, 7, 15 

Binary mapping MO2_Static_2Cha 

MO3_Static_3Cha 

MO4_Static_4Cha 

0 .. 3 

0 .. 7 

0 .. 15 
 

If [MOValue] is invalid – i.e., the value exceeds the permitted range for the 
assigned number of outputs, then 
 a quality error message (Reliability) is generated  

[Quality = MULTISTATE_FAULT]  
 a backup value becomes valid according to the value in [BackupMode].  
 
If the TX-I/O BIM is in the status 'Masterdown', a backup value becomes valid 
according to [BackupMode]. 
 
 
4.8.10 Channel Diagnosis 
 

Alarm type Cause / solution 

Invalid Check the module configuration and parameterization 

No_Output Operating voltage too low -> check the power 

Multistate_Fault Mapping error in a multistate function 

 
 

MOValue value range 

Masterdown 
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4.9 Multistate Output Mapping (Pulse) 
 

MO(X)_PULSE_(X)CHA_(X) (SIMATIC Manager hardware catalog)  
 
Parameter for mapping the multistate process value to a specific number of output 
channels. 
 
The multistate output (pulse) is similar to the function of 
the Q250-P (BO_OnOff_Pulse).  
The function has n combined outputs. n is independent 
of the TX-I/O module that is used.  
The function ensures that only one output can be active 
at any one time.  
If a new process value is set, the following steps are 
performed in succession: 
The OFF relay [Out_X(n)] is activated  
The OFF relay [Out_X(n)] enables the circuit  
The OFF relay [Out_X(n)] is disabled  
One of the contact relays [Out:X(n+1)]… [Out:X(n+s)] is 
activated 
After the pulse has expired, the corresponding contact 
relay is disabled. 
 

Note 
 The first channel of the [MO_PULSE] function is always the OFF channel.  
 If a pulse with the pulse length [MinOffTime] was generated in the OFF channel 

before a change in the value [MOValue], it cannot be interrupted by changing 
the value. 

 
We distinguish between three different [MO(n)_PULSE] function types. The 
following table shows the channels in regard to function and representation in the 
SIMATIC Manager hardware catalog:  
 
Channels Relevant submodules,  

representation in the Simatic Manager hardware catalog  

2-stage, 3-channel MO2_Pulse_2Cha_Off 

MO2_Pulse_2Cha_St1 

MO2_Pulse_3Cha_St2 

3-stage, 4-channel MO3_Pulse_3Cha_Off 

MO3_Pulse_3Cha_St1 

MO3_Pulse_3Cha_St2 

MO3_Pulse_3Cha_St3 

4-stage, 5-channel MO4_Pulse_4Cha_Off 

MO4_Pulse_4Cha_St1 

MO4_Pulse_4Cha_St2 

MO4_Pulse_4Cha_St3 

MO4_Pulse_4Cha_St4 
 

Important 
These function groups must be inserted in the subslots 
 without any changes to the order and 
 in direct succession to each other. 
 
 

Representation 

Definition, addition 

Function 

Function types 

Representation  
of the channels 
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4.9.1 Backup Mode 
 

Function for control of the behavior of the function when changing to the 
'MasterDown' status. 
 
Possible values Description 

NO Process value = INACTIVE, 0 (Off) 

VALUE Specific value of the parameter [BOBackupValue] 

KEEP Save the last active process value 

 
 

4.9.2 MO Backup Value 
 

Parameter – type [BinaryValueEnum] – that represents the backup value and 
becomes valid in the following cases:  
 a change in status to 'MasterDown' and 
 the parameter [BackupMode] = VALUE 
 
Possible values Description 

ACTIVE Binary output is active. 

INACTIVE Binary output is inactive. 
 
Backup values are the same values as the process data values for the channels. 
For information, refer to 'Process Data Channel Mapping' of each TX-I/O module 
with MO function.  
 
 

4.9.3 Minimum OFF Time  
 

Parameter for defining the minimum pulse length for the OFF channel (first 
channel).  
 
Value range Unit 

1...255 0.1 s 

 
 

4.9.4 Pulse Time 
  

Parameter for defining the pulse length for contact channels (2…n).  
 
Value range Unit 

1...255 0.1 s 

 
 

4.9.5 Enabling Local Override 
 

Parameter for enabling/disabling the module key Up/Down for the 'Local override' 
function.  
 
General switching behavior (for enabled local overriding): 
 Switch from automatic to local override (manual): 

The current process value is valid until a new manual command is issued.  

Definition, addition 

Definition, addition 

Definition, addition 

Definition, addition 

Definition, addition 

Switching behavior 
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 Switch from local override to automatic: 
The automatic process value becomes valid once the Profinet I/O controller 
writes a new value.  

 
Possible values Description 

Selected Enabled 

Not selected Disabled 

 
 

4.9.6 Local Override Mode 
 

Parameter for defining the type of 'local override' signal. 
A logical '1' is usually interpreted as 'active'. However, it is possible for migrations 
to interpret a logical '0' as 'active'. 
 
The following assignments apply here: 
 
Value Input Local override 

Active 1 Active 

Inactive 0 Active 

Active 0 Inactive 

Inactive 1 Inactive 

 
 

4.9.7 Process Data 
 

The allocation of process data and the channel status information of multistate 
output-configured channels for local override are described in 'Process Data 
Channel Mapping' for the corresponding TX-I/O module. 
 
[MOValue] represents the current status. During the 'off' pulse, [MOValue] changes 
to '0'. During the delay period [MinOffTime] the current [MOValue] differs from the 
commanded value.  
 
If [MOValue] is invalid (i.e., no corresponding channel is available), then  
 a quality error message (Reliability) is generated:  

[Quality = MULTISTATE_FAULT]  
 a backup value becomes valid according to the value in [BackupMode].  
 
 

4.9.8 Channel Diagnosis 
 

Alarm type Cause / solution 

Invalid Check the module configuration and parameterization 

No_Output Operating voltage too low -> check the power 

Multistate_Fault Mapping error -> check the multistate functions 

 
If the TX-I/O BIM has the status 'Masterdown' after a start, no new output pulses 
are generated, regardless of the value [BackupMode].  
 
If local override is active after starting the TX-I/O, an output pulse defined by 
[MOValue] will be generated.  

Definition, addition 

Read MOValue 

Invalid MO Value 

Masterdown 

Local override 
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4.10 Analog Input (Measure) 
 

AI_XXX (SIMATIC Manager hardware catalog)  
 
Parameter for converting analog measurement values to standard SIMATIC values.  
Analog values and corresponding SIMATIC values are described further below 
under 'Process Data'.  
 
TX analog inputs can be handled like S7 analog inputs:   
 Temperature sensors use the same values as the SIMATIC modules; we 

distinguish between the following:  
– 'Climatic' (resolution: 0.01 °C; range: 50…150 °C) and 
– 'Standard' (resolution: 0.1 °C; range: 50…400 °C) 

 
 Voltage and current measurements use the range 0 to 27648. Consequently, the 

rated sensor ranges 0…20 mA, 0…10 V and 4…20 mA are covered. 
 
 (Measurement) errors detected by the module are indicated as an overflow 

value (32767) or underflow value (32768). 
 
 Resistance measurements have different ranges and conversions compared 

with SIMATIC analog inputs. For further information, refer to the corresponding 
table under 'Resistance Measurement' further below in this section. 

 
 

4.10.1 Representation in the SIMATIC Manager Hardware 
Catalog  

 

The following inputs are represented in the SIMATIC Manager hardware catalog: 
 
AI_U10N AI_PT1K375 AI_NTC10K 

AI_I020 AI_PT1K385 AI_NTC100K 

AI_I420N AI_R2K5 AI_PT100_4_Climatic 

AI_NI1K AI_T1 AI_PT100_4_Standard 

 
 
4.10.2 Functions 
 

Voltage measurement 

SIMATIC HW 
catalog 

Description Rated 
measurement 
range 

Maximum 
measurement 
range 

Resolution 

AI_U10N DC voltage 
measurement 
(0…10 V) 

0…10 V  1.5 V… 11.5 V 1/1000 V 

 
Current measurement 

SIMATIC HW 
catalog 

Description Rated 
measurement 
range 

Maximum 
measurement 
range 

Resolution 

AI_I020 DC measurement 
(0…20 mA) 

0…20 mA  3.0… 23 mA 1/1000 mA 

Representation 

Definition, addition 

S7 software 

Voltage measurement 

Current measurement 
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Resistance measurement 
Resistance measurement 

SIMATIC HW catalog Description Rated 
measurement 
range 

Maximum 
measurement 
range 

Resolution 

AI_NI1K Temperature  
LG-Ni1000 

 50… 150°C  52.5… 185°C 1/100 K 

AI_PT1K385 Temperature Pt 1000 

Standard 

 50… 400°C  52.5… 610°C 1/10 K 

AI_R2K5 Resistance 0..250Ω 2 
wire 

0..2500 Ω 0..2650 Ω 1/10 Ω 

AI_T1 Temperature (PTC)  50… 130°C  52.5… 155°C 1/100K 

AI_NTC10K Temperature NTC 
10k 

 40… 115°C  52.5… 155°C 1/100 K 

AI_NTC100K Temperature NTC 
100k 

 40… 125°C  52.5… 155°C 1/100 K 

AI_PT100_4_Climatic Temperature PT100 
Climatic 

 50… 180°C  52.5… 185 °C 1/100 K 

AI_PT100_4_Standard Temperature PT100 
Standard 

 50… 400°C  52.5… 610 °C 1/10 K 

 
 

4.10.3 Compensation 
 

Parameter for setting a compensation value for the conductor resistance.  
The compensation value is subtracted from the result of the resistance 
measurement. It is used for all signal types with two-wire resistance sensors.  

Exceptions: NTC 10K and NTC 100K. 
 
Value range Unit 

0...65535 0.01 ohm 

 
 

4.10.4 Representation of Analog Values 
 

SIMATIC value Analog value Description 

Decimal Hex   

32767 7FFF 11.8515 V 

31458 7AE2 11.3780 V 
Overflow; measurement faulty 

31457 7AE1 11.3777 V 

27649 6C01 10.0004 V 

Overshoot range; measurement is correct, measurement 
accuracy is no longer assured 

27648 6C00 10.000 V 

20736 5100 7.5000 V 

1 1 0.0004 V 

0 0 0 V 

Rated range 

 32768 8000 < 0 V Underflow; conductor interruption 

 
SIMATIC value Analog value Description 

Decimal Hex   

32767 7FFF 23.703 mA 

32512 7F00 23.5181 mA 
Overflow; measurement faulty 

32511 7EFF 23.5178 mA 

27649 6C01 20.0007 mA 

Overshoot range; measurement is correct, measurement 
accuracy is no longer assured 

27648 6C00 20.0000 mA 

20736 5100 15.0000 mA 

1 1 0.7234 μA 

Measurement range 

Definition, addition 

Voltage measurement 
(0…10 V) 

Current measurement 
(0 mA...20 mA) 
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SIMATIC value Analog value Description 

Decimal Hex   

0 0 0.0000 mA 

 4146 EFDB – 3.0000 mA Underflow range 

 4147 EFDA – 3.0007 mA 

 32768 8000 < – 3 mA 

Underflow 

 
 
SIMATIC value Analog value Description 

Decimal Hex   

32767 7FFF > 23.52 mA 

31795 7F00 23.5207 mA 
Overflow; measurement faulty 

31794 7C32 23.52 mA 

27649 6C01 20.0007 mA 

Overshoot range; measurement is correct, measurement 
accuracy is no longer assured 

27648 6C00 20 mA 

20736 5100 12 mA 

1 1 4.0006 mA  

0 0 4 mA 

Measurement range 

 
Table for the 'Climatic' temperature measurement sensor. 
AI_NI1K  
AI_PT1K375 

AI_T1  
AI_NTC10K 

AI_NTC100K 
AI_PT100_4_Climatic

 
SIMATIC value Analog value Description 

Decimal Hex   

32767 7FFF > 155 … > 185 °C 

32512 7F00  
Overflow, line interruption 

15500…18500  155.00 …185.00 °C 

11501…18001   

Upper limit range 

Overshoot range 

11500…18000  115.00 … 180.00 °C 

10000  100.00 °C 

1  0.01 °C 

0  0 °C 

 1   0.01 °C 

 3999… 4999   

 4000… 5000   40.00… 50.00 °C 

Measurement range 

Rated range 

Varies according to sensor type 

4001… 5001   

 5250   52.50 °C 

Underflow range 

Lower limit range 

 32513 80FF  

 32768 8000 <  52.50 °C 
Underflow, short-circuit 

 
Refer also to the rated ranges / limit ranges in the following tables. 

 
Table for the extended temperature range of the platinum sensors. 
AI_PT1K385  
AI_PT100_4_Standard  
 
SIMATIC value Analog value Description 

Decimal Hex   

32767 7FFF > 610 °C 

32512 7F00  
Overflow 

6100  610°C 

4001   

Upper limit range 

Overshoot range 

4000  400.0 °C 

1000  100.0 °C 

1  0.1 °C 

Measurement range 

Rated range 

Varies according to sensor type 

Current measurement 
(4 mA...20 mA) 

Temperature sensor 
'Climatic' range 

Temperature sensor 
'Standard' range 
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0  0 °C 

 1   0.1 °C 

 1000   100.0 °C 

 5000   50.00 °C 

 5001   

 5250   52.50 °C 

Underflow range 

Lower limit range 

 32513 80FF  

 32768 8000 <  52.50 °C 
Underflow 

 
SIMATIC value Analog value Description 

Decimal Hex   

32767 7FFF >256  / 2.56 k 

26500 7F00  
Overflow 

26499  256  / 2.56 k 

25001   

Upper limit range 

Overshoot range 

25000  250  / 2.5 k 

10000  100  / 1 k 

1  0.01  / 0.1  

0  0  

Rated range 

 
 

4.10.5 Channel Diagnosis 
 

Alarm type Cause / solution 

Invalid Check the module configuration and parameterization 

No_Output Operating voltage too low -> check the power 

Over_Range Sensor shows a higher value than the rated range > check the sensor output 

Under_Range Sensor shows a lower value than the rated range > check the sensor output 

Short_Loop The connection between the sensor and module shows a value that indicates a 
short-circuit > check the sensor and cable connection between the sensor 
and module 

Open_Loop The connection between the sensor and module shows a value that indicates an 
interruption > check the sensor and cable connection between the sensor 
and module 

No_Sensor The 4...20 mA current measurement signal indicates the value No_Sensor if no 
current was measured. 

> check the sensor and cable connection between the sensor and module 

Unreliable The operating voltage ACDC 24 V is below a specific value (AC or DC) > check the 
operating voltage value (power supply) 

  

Function S
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AI_U10N  X X X  X 

AI_I020  X X  X X 

AI_I420N  X X  X X 

AI_NI1K X X X X   

AI_PT1K375 X X X X   

AI_PT1K385 X X X X   

AI_R2K5   X X   

AI_T1 X X X X   

AI_NTC10K X X X    

Resistance 
measurement 

Error messages 
(overview) 
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AI_NTC100K X X X    

AI_PT100_4_Climatic X X X X   

AI_PT100_4_Standard X X X X   
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4.11 Analog Output (Positioning) 
 

AO_U10N, AO_I420N (SIMATIC Manager hardware catalog)  
 
Parameter for changing/mapping the process value [AOValue] as a SIMATIC 
standard analog value.  
 
 

4.11.1 Functions 
 

DC voltage output. 
 
Voltage measurement 

SIMATIC HW 
catalog 

Description Rated output range Maximum output 
range 

Resolution 

AI_U10N DC voltage output 0…10 V  0.054 V… 
 10.66 V 

 

 
DC current output. 
  
Voltage measurement 

SIMATIC HW 
catalog 

Description Rated 
measurement 
range 

Maximum 
measurement 
range 

Resolution 

AI_U10N DC output 4…20 mA  16/10000 mA 

 
 

4.11.2 Backup Mode 
 

Function for control of the behavior of the function when changing to the 
'MasterDown' status. 
 
Possible values Description 

NO Process value = INACTIVE, 0 (Off) 

VALUE Specific value of the parameter [BOBackupValue] 

KEEP Save the last active process value 

 
 

4.11.3 AO Backup Value 
 

Parameter – type [AnalogValueEnum] – that represents the backup value and 
becomes valid in the following cases:  
 a change in status to 'MasterDown' and 
 the parameter [BackupMode] = VALUE 
 
Value range 

-32768 .. +32767 

 
 

Representation 

Definition, addition 

AO_U10N 

AO_I420N 

Definition, addition 

Definition, addition 
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4.11.4 Enabling Local Override 
 

Parameter for enabling/disabling the module key Up/Down for the 'Local override' 
function.  
 
General switching behavior (for enabled local overriding): 
 Switch from automatic to local override (manual): 

The current process value is valid until a new manual command is issued.  
 Switch from local override to automatic: 

The automatic process value becomes valid once the Profinet I/O controller 
writes a new value.  

 
Possible values Description 

Selected Enabled 

Not selected Disabled 

 
 

4.11.5 Local Override Mode 
 

Parameter for defining the type of 'local override' signal. 
A logical '1' is usually interpreted as 'active'. However, it is possible for migrations 
to interpret a logical '0' as 'active'. 
 
The following assignments apply here: 
 
Value Input Local override 

Active 1 Active 

Inactive 0 Active 

Active 0 Inactive 

Inactive 1 Inactive 

 
 

4.11.6 Process Data 
 

The allocation of process data and the channel status information of analog output-
configured channels for local override are described in 'Process Data Channel 
Mapping' for the corresponding TX-I/O module.  
 
If the TX-I/O BIM is in the status 'Masterdown', the backup functions become active. 
The backup function then works in the mode defined by the value in the parameter 
[BackupMode].  
 
If the channel is set to local override, [AOValue] is limited to the rated value range.  
 
 

4.11.7 Representation of Analog Values 
 

 
SIMATIC value Analog value Description 

Decimal Hex   

32767 7FFF 

29310  
11.14 V Overflow, operating voltage off 

29309  10.66 V 

27649 6C01  
Overshoot range 

27648 6C00 10 V Measurement range 

Definition, addition 

Switching behavior 

Definition, addition 

Masterdown 

Local override 

Voltage output (0…10 V
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SIMATIC value Analog value Description 

Decimal Hex   

20736 5100 7.5 V 

1 1 361.7 µV 
0 0 0 V 

-1 FFFF 361.7 µV 

-141  -54 mV 

Underflow, not supported 

Output value limited to 0 V 

  

-32767…-142  

  

-32768  

0.00V 

Underflow, not supported 

Output value limited to 0 V 

Channel diagnosis: Under_Range 

 
  
SIMATIC value Analog value Description 

Decimal Hex   

32767 7FFF 

32512 7F00 
0.00 mA Overflow, operating voltage off 

32511 7EFF 22.81 mA 

27649 6C01  
Overshoot range 

27648 6C00 20 mA 

20736 5100 15 mA 

1 1 4mA  578.7 nA 

0 0 4 mA 

Measurement range 

-1 FFFF 

-20736 E500 
Underflow range 

-27648 E4FF 

-32512 8100 

Not supported, output value limited to 
0 mA 

-32513 80FF 

  

0 mA 

Underflow, no voltage/no current 

 
 

4.11.8 Channel Diagnosis 
 

Alarm type Cause / solution 

Invalid Check the module configuration and parameterization 

No_Output Operating voltage too low -> check the power 

Over_Range Sensor shows a higher value than the rated range > check the output process 
value 

Under_Range Sensor shows a lower value than the rated range > check the output process 
value 

Short_Loop The connection between the sensor and module shows a value that indicates a 
short-circuit > check the sensor and cable connection between the sensor 
and module 

Open_Loop The connection between the sensor and module shows a value that indicates an 
interruption (open loop) > check the sensor and cable connection between 
the module and field device 

Unreliable The operating voltage ACDC 24 V is below a specific value (AC or DC) > check the 
operating voltage value (power supply) 

 
 

Current output 
(4 mA...20 mA) 
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4.12 Continuous 3-Point Analog Output 
 

AO_Y250T_2Cha_1_Open (SIMATIC Manager hardware catalog) 
AO_Y250T_2Cha_2_Close (SIMATIC Manager hardware catalog)  
 
Continous 3-point analog output with two channels for positioning drives.  
This function is used for the open/close control of three-position drives without 
feedback (without a position potentiometer) – for example, for 
 valve drives 
 Damper actuators 
 Third-party drives 
 
 

4.12.1 Function 
 

The function uses two channels. These must 
 be in the same module and 
 follow in direct succession. 
 
An internal stroke model (path algorithm) [StrkPos] calculates the required length of 
the open or close pulses from the drive cycle time and the position defined by the 
process value. No feedback is required by the drive.  
 
The function supports asymmetric drives with different opening and closing cycle 
times under the condition that this is also supported by the automation station.  
 
AO_Cont3Point_Simple  

SIMATIC HW catalog Description 

AO_Y250T_2Cha_1_Open 'Open' channel for the AO_Cont3Point_Simple function 

AO_Y250T_2Cha_2_Close 'Close' channel for the AO_Cont3Point_Simple function 

 
The function converts the process value [AOValue] to a 3-position signal. A stroke 
model [StrkPos](path algorithm) continuously simulates the position of the drive 
based on the incoming control commands, and calculates the required length of 
the open and close pulses from the drive cycle time and the position defined by the 
process value. It therefore represents the drive position at all times. As a result, the 
drive does not require corresponding feedback signals.   
 
For full integration of all of the functionality – including the resulting stroke position 
[StrkPos] and the function status [FncSta] – the 'Cluster Object Model' must be 
applied (as described in PD622-F-0012 – Architectural Concepts).   
 
 

4.12.2 Backup Mode 
 

Function for control of the behavior of the function when changing to the 
'MasterDown' status. 
 
Possible values Description 

NO Process value = INACTIVE, 0 (Off) 

VALUE Specific value of the parameter [BOBackupValue] 

KEEP Save the last active process value 

 
 

4.12.3 AO Backup Value 

Representation 

Definition, addition 

Positioning model 

Full functionality 

Definition, addition 
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Parameter – type [AnalogValueEnum] – that represents the backup value and 
becomes valid in the following cases:  
 a change in status to 'MasterDown' and 
 the parameter [BackupMode] = VALUE 
 
Value range Unit 

0...10000 0.01 % 

 
 

4.12.4 StartSynchronization  
 

Parameter – type [SynchEnum] – for synchronization after a reset. 
The synchronization cannot be interrupted. After a reset the current position of the 
stroke model is set to 0 % before the synchronization is started.   
 
Possible values Description 

NONE No synchronization 

SINGLEOPEN Immediate opening synchronization for 1.5  [rise time] 

SINGLECLOSE Immediate closing synchronization for 1.5  [fall time] 

 
 

4.12.5 LimitSynchronization 
 

Parameter for stopping a drive at specified end positions. In doing so, [StrkPos] is 
set to [AOValue] at the same time.  
While [LmStp]=TRUE,  
 all synchronization types remain irrelevant 
 any ongoing synchronization operation is cancelled 
If the local override function is active, [LmStp] is set to FALSE.  
 

Note 
The function becomes even more useful if an end position detection function is 
available with an additional input and a correspondingly assigned end switch.  
 
Possible values Description 

Selected No synchronization 

Not selected Stop 

 
 

4.12.6 StartSynchronization 
 

Parameter for starting the synchronization. 
 StartSynchronisation is automatically triggered after a reset if this has been 

specified accordingly.  
 The synchronization is not interrupted by any other event.  
 
 
Possible values Description 

NONE No synchronization 

SINGLEOPEN Immediate 'Open' synchronization for 1.5  [rise time] 

SINGLECLOSE Immediate 'Close' synchronization for 1.5  [fall time] 

 

Definition, addition 

Definition, addition 

Definition, addition 

Definition, addition 
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Note 
Before you activate the synchronization after a reset, set the position in the 
positioning model to 0 %.  
 

Recommendation: NONE – no synchronization 
Every other configuration can cause unpredictable drive actions (valve, damper 
drives).  
 
 

4.12.7 LimitSynchronization 
 

Parameter for defining the behavior of the synchronization if 
 [AOValue] reaches a final position (0% or 100%) and  
 the positioning model is within ([neutral zone]/2 + hysteresis) – i.e., the 

positioning model considers the drive as fully open or fully closed.  
The synchronization is interrupted if [AOValue] changes to a value  
> 0% + [NeutralZone]/2 + hysteresis or  
< 100% – ([NeutralZone]/2 + hysteresis).    
 
Possible values Description 

NONE No synchronization 

CONTINUOUS Continuous synchronization (0% and 100%) 

SINGLE Synchronization for 1.5  [rise time] (100%) or  
1.5  [fall time] (0%) 

EVERY10MIN Synchronization for 1.5  [rise time] (100%) or  
1.5  [fall time] (0%) every 10 minutes 

EVERY20MIN Synchronization for 1.5  [rise time] (100%) or  
1.5  [fall time] (0%) every 20 minutes 

CONTINOPEN Continuous synchronization (100%) 

SINGLEOPEN Synchronization für 1.5  [rise time] (100%)  

EVERY10MINOPEN Synchronization für 1.5  [rise time] (100%) every 10 
minutes 

EVERY20MINOPEN Synchronization für 1.5  [rise time] (100%) every 20 
minutes 

CONTINCLOSE Continuous synchronization (0%) 

SINGLECLOSE Synchronization für 1.5  [fall time] (100%)  

EVERY10MINCLOSE Synchronization für 1.5  [fall time] (100%) every 10 minutes 

EVERY20MINCLOSE Synchronization für 1.5  [fall time] (100%) every 20 minutes 
 

Recommendation: SINGLE  
Every other configuration can cause unpredictable drive actions (valve, damper 
drives).  
 
 

4.12.8 RiseTime 
 

Parameter for defining the open time of a valve, flap, etc. 
 
Value range Unit Recommended range 

63...65535 0.1 s 6.5...600 s 
 
The open time (0 % to 100 %) can be defined within the range specified above.  
 
 

Definition, addition 

Definition, addition 
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4.12.9 FallTime 
 

Parameter for defining the close time of a valve, flap, etc. 
 
Value range Unit Recommended range 

63...65535 0.1 s 6.5...600 s 
 
The fall time (100% to 0 %) can be defined within the range specified above. 
 
 

4.12.10 BreakTime 
 

Parameter for defining the break time (pause) when a drive changes direction 
(open/close).  
 
Value range Unit 

0...255 0.1 s 
 
 

4.12.11 NeutralZone 
 

Parameter for setting the percentage share of the extent of a neutral zone (in 
relationship to the required time).  
 
Value range Unit 

0...20 0.1 s 
 
Is the difference between the process value and path algorithm greater than half of 
the neutral zone plus hysterisis, a pulse of appropriate length and direction is 
generated until the difference value is again within the neutral zone.  
 
 

4.12.12 Hysteresis (Switching Limit) 
 

Parameter for defining the component of deviation between [StrokeModel] and the 
process value [AOVal].  
The process value must be reached until the [StrokeModel] has been adjusted and, 
as a result, an OnCmd or OffCmd pulse has been generated..  
  
The entire deviation Yctr in the figure below must comply with the following 
condition:   







  HysteresiseNeutralZonYctr 2

 

 

 
 
 

Definition, addition 

Definition, addition 

Definition, addition 

Function 

Definition, addition 
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The minimum pulse times are defined by, among other factors, the hysteresis [Hys] 
properties. Where:  
Minimum pulse length for OnCmd = [Hys]  [RiseTime] 
Minimum pulse length for OffCmd = [Hys]  [FallTime] 
 
Value range Unit 

0...20 %2 
 
 

4.12.13 Enabling Local Override 
 

The local override function for the channel is enabled by pressing the rocker switch 
of a channel. The following assignments apply in this case.  
Pressure on… 
 ... middle (hand): local override ON / OFF; no 

change at the output. The yellow 
LED of the channel lights while the 
override function is switched on 

 ... +  (up):  connected device on; I/O point (n) 
 ... –  (down): connected device off; I/O point (n+1) 
 

The stroke algorithm is updated when the local override function is activated. 
 

The local override function can be disabled in the configuration.  
 
The TXM1.6R-M module enables local override. Press the rocker switch of either 
of the two channels. The following applies: pressure on… 
 
  

4.12.14 Local Override Mode 
 

Parameter for defining the type of 'local override' signal. 
A logical '1' is usually interpreted as 'active'. However, it is possible for migrations 
to interpret a logical '0' as 'active'. 
 
The following assignments apply here:  
Value Input Local override 

Active 1 Active 

Inactive 0 Active 

Active 0 Inactive 

Inactive 1 Inactive 

 
 

4.12.15 Process Data 
 

The allocation of process data and the channel status information of analog output-
configured channels for local override are described in 'Process Data Channel 
Mapping' for the corresponding TX-I/O module.  
 
If local override is active after starting the TX-I/O, [StrokeModel] is set to the value 
of the last override value. As a result, the relay remains inactive and the drive is 
immobile.  
 
If the TX-I/O BIM is in the status 'Masterdown', the backup function becomes active. 
The backup function works in the mode defined by [BackupMode].  

Hysteresis 

Manual operation 

Definition, addition 

Local override 

Masterdown 



 61 / 94 

Siemens TX-I/O PROFINET BIM V1.0 CM110564en_02 
Building Technologies Parameters 23.09.2010 

 
SIMATIC value Analog value Description 

Decimal Hex   

32767 7FFF  

27649 6C01  
Value limited to 100 % (no faults) 

27648 6C00 100 % 

20736 5100 75 % 

1 1  

0 0 0 % 

Measurement range 

-1 FFFF  

-32768 —  
Value limited to 0 % (no faults) 

 
 

4.12.16 Channel Diagnosis 
 

Alarm type Cause / solution 

Invalid Check the module configuration and parameterization 

No_Output Operating voltage too low -> check the power 

No_Output AC/DC 24 V voltage lower than minimum value >  
check the power supply 

 
 
 
 

SIMATIC representation 
of analog values 
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5 Diagnostics 
5.1 Diagnostics with the SIMATIC Manager 
 

Identification-related diagnostics are used to diagnose the Profinet BIM.   
The function block DIAG-DESIGO-IO is provided in the Emx to evaluate the 

diagnostics data with the SICLIMAT X environment. 
 
 

5.1.1 Basic Diagnostics 
 

The following diagnostics information is displayed in the module information window:  
 the firmware version 
 the hardware version 
 MLFB number (machine-readable production number = order number) 
 Ethernet port statistics 
 
1. SIMATIC Manager, left screen section: Mark CPU > menu: Target system > 

Show accessible nodes 
Opens the Accessible Nodes dialog box  

2. General tab, group field: Version > Version  

  
3. Identification tab, group field: Manufacturer information > Serial number  

  
4. Statistics tab  

  
5. Close button. 

Closes the dialog box. 

5.1.2 Advanced Diagnostics 

Step-by-step procedure 

Version and MLFB  
(order number)  

Serial number 

Ethernet port statistics 
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The following diagnostics information is displayed in the module information 
window:  
 Diagnostics alarm list per device/function object/channel 
 
1. SIMATIC Manager, left screen section: Mark CPU > menu: Target system > 

Show accessible nodes 
Opens the Accessible Nodes dialog box  

2. IO Device Diagnostics tab, group field: Standard diagnstics and Channel-
specific diagnostics  

 
 
 

5.1.3 Diagnostics Alarms 
 

 
German English Alarm # 

Kurzschluss Short Circuit 1 

Unterspannung Under Voltage 2 

Überspannung Over Voltage 3 

Überlast Over Load 4 

Übertemperatur Over Temperature 5 

 Line Break 6 

Obere Grenze überschritten Upper Limit Exceeded 7 

Untere Grenze überschritten Lower Limmit Exceeded 8 

Fehler Error 9 

Ungültig Invalid 16 

Gerätefehler Device Fault 17 

Kein Fühler No Sensor 21 

Ausgang gesperrt Output Disabled 24 

Multistate-Fehler Multistate Fault 27 

 Break Fault 29 

 
 

Procedure 

Version and MLFB  
(order number)  
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5.2 Diagnostics on Profinet BIM 
 

 
LED indication  

 
Description 

R
u

n
 

F
LT
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in

k1
 

C
o

m
m

 1
 

L
in

k2
 

C
o

m
m

 2
 

Cause 

on off     Firmware runs without faults 

on flashing     Alarm present 

on on     Firmware is running, no Profinet 
communication  

flashing flashing     Hardware problem 

flashing off     Firmware update is running, firmware is 
running  

flashing on     Firmware update is running, firmware is 
not running  

off on     Firmware is not running 

  on    Connection to Ethernet port 1 available 

    on  Connection to Ethernet port 2 available 

   flickerin
g 

  Ethernet communication on port 1 

     flickerin
g 

Ethernet communication on port 2 

 
 

5.3 Diagnostics in Telnet 
5.3.1 Telnet Commands 
 

The following commands are used on the DOS command level for working with 
Telnet: 
  
help firmware 

Command Description 

fwupdate Starts firmware update 

cimiupdate Starts CIMI firmware update 

cfgget Get device configuration 

cfgupdate Update device configuration 

calibrate Starts CIMI calibration 

devicestop Stops Profinet IO Device 

devicestart Starts Profinet IO Device 

setPvMode Sets ComMode of a device  
to Master/Slave or Frontend/Backend 

 
help info 

Command Description 

devicelist Shows the device and module list 

alarmlist Shows the active alarms 

diagbasic Display the diagnostic and process 
alarms 

diagextended Display the extended diagnosis 

ethstats Display the ethernet statistics 

showlog Display trace log 

version Display the firmware version 
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5.3.2 Authentication 
 

Defined user names and assignment of corresponding rights.  
The user names and passwords are used for the login procedure.  
 
User name Password Rights 

guest guest01 Read rights (monitoring) 

user user01 Firmware configuration updates and monitoring 

root root All rights 

 
You access the login dialog automatically when opening telnet. 
Start > Run  
Enter cmd > OK in the text box 

Opens the DOS commander  
1 Optional (recommended): navigate to the directory C:\temp with 

cd c:\temp > return key  
2 At the DOS prompt (C:\temp>) enter: telnet > return key 

Starts Telnet and shows the welcome text  
3 At the DOS prompt (Microsoft Telnet>) enter the IP address of the TX-I/O BIM:  

open xxx.xxx.xxx.xxx > return key 
Refreshes the screen and displays the login prompt  

4 At the DOS prompt (login:) enter: telnet > return key  
5 At the DOS prompt (password:) enter (hidden text input): user01 > return key 

Displays 'Welcome user' and prompts with PNBIM>  
6 Continue with the following options: 
 

 Version  Basic Diagnostics  Alarm List 
 Configuration  Advanced Diagnostics  Device List 
 
 Optional: Exit by entering at the DOS prompt: quit > return key 

 
 

5.3.3 Version  
 

Command for displaying the loaded firmware versions. 
 
1 At the DOS prompt (PNBIM>) enter: version > return key 

Shows the version parameters of the firmware (see the example below)  
2 Continue by entering at the DOS prompt or exit with quit > return key 
 

 
 
 

Definition, addition 

Step-by-step procedure 

Definition, addition 

Procedure 
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5.3.4 Configuration 
 

Command for displaying the configuration data.  
 
At the DOS prompt (PNBIM>) enter: cfgget > return key 

Shows the configuration parameters of the TX-I/O BIM; (see the example 
below)   

1 Continue by entering at the DOS prompt or exit with quit > return key 
 

 
 
 

5.3.5 Basic Diagnostics 
 

Command for running and displaying the basic diagnostics. 
 
1 At the DOS prompt (PNBIM>) enter: diagbasic > return key 

Shows the basic diagnostics parameters of the TX-I/O BIM; the following 
parameters are listed (see the example below)  

 
 Firmware version  CIMI firmware version  Serial number 
 Hardware version  MLFB number  Ethernet port statistics

 

  
2 Optional: Exit by entering at the DOS prompt: quit > return key 
 
 

5.3.6 Advanced Diagnostics 
 

Command for running and displaying the basic diagnostics and for writing the 
advanced diagnostics to a file (diagext.file). 

The file created with this command can be downloaded via FTP. 
 
1 At the DOS prompt (PNBIM>) enter: diagextended > return key 

Shows the parameters of the extended diagnostics of the TX-I/O BIM; the 
following parameters are listed: 
 Diagnostics alarm list per device/function object/channel 
 Exception history (see the following example)  
 Log history 

 

Definition, addition 

Procedure 

Definition, addition 

Procedure 

Definition, addition 

Procedure 
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2 Optional: Exit by entering at the DOS prompt: quit > return key 
 
 

5.3.7 Alarm List 
 

Command for displaying the alarm list. 
This command can only be run during ongoing Profinet communication.  

 
1 At the DOS prompt (PNBIM>) enter: alarmlist > return key 

Shows the alarm list; for example: 
 

  
2 Optional: Exit by entering at the DOS prompt: quit > return key 
 
 

5.3.8 Device List 
 

Command for displaying a TX-I/O module list for modules that are connected with 
the Profinet BIM. 

This command can only be run during ongoing Profinet communication.  
 
1 At the DOS prompt (PNBIM) enter: devicelist > return key 

Shows the device list; for example: 
 

  
2 Optional: Exit by entering at the DOS prompt: quit > return key 

Definition, addition 

Procedure 

Definition, addition 

Procedure 
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6 Updates 
6.1 Firmware Update 
6.1.1 FW Upload to TX-I/O BIM 
 

1 Download the zip file pnbim firmware Vxxx.zip and the GSDML file (.xml) from 
Swanweb  
The following link is an example and is neither binding nor complete (you 
need to navigate further, but this is self-explanatory) 
https://intranet.sbt.siemens.com/swanlink/default.php?tabcard=4b73a4b5&src
=txio/asn/TXB1.Profinet  

2 Extract the file pnbim_fw_V0_2_xx.bin and copy it together with the GSDML 
file to a local folder – e.g., C:\temp.  

 
Passwords are required below during the login procedure.  
 
User name Password Rights 

guest guest01 Read rights (monitoring) 

user user01 Firmware configuration updates and monitoring 

root root All rights 

 
1 Start > Run  
2 Enter cmd in the text box and then return key 

Opens the DOS commander  
3 Optional (recommended): navigate to the folder named above (e.g., C:\temp) 

with cd c:\temp > return key  
4 At the DOS prompt (C:\temp>) enter: ftp > return key 

Prompts ftp>  
5 At the DOS prompt (ftp>) enter the IP address of the TX-I/O BIM:  

open xxx.xxx.xxx.xxx > return key 
Displays 'Connected to <IP address> and 220 Service ready'  

6 At the DOS prompt User (<IP address>: (none)) enter: user > return key 
Display '331 User name ok, need password'  

7 At the DOS prompt (password:) enter (hidden text input): user01 > return key 
Displays '230 User logged in'  

8 At the DOS prompt (ftp>) enter:  
put pnbim_fw_Vx_x_xx.bin > return key 
Displays '200 Command OK, 150 Connecting for STOR, 226 Transfer OK, 
Closing connection' and 'ftp: xxxxxx bytes sent in xxx.xx Seconds 
xx.xxKbytes/s.'   

9 At the DOS prompt (ftp>) enter: quit > return key 
Exits ftp 

 

 

Preparation 

Passwords 

Step-by-step procedure 

https://intranet.sbt.siemens.com/swanlink/swl_supp/txio/asn/txb1.profinet/v0.2.17/pnbim_firmware_V0_2_17.zip�
https://intranet.sbt.siemens.com/swanlink/default.php?tabcard=4b73a4b5&src=txio/asn/TXB1.Profinet�
https://intranet.sbt.siemens.com/swanlink/default.php?tabcard=4b73a4b5&src=txio/asn/TXB1.Profinet�
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6.1.2 Firmware Update of PROFINET BIM 
 

1 Start > Run  
2 Enter cmd in the text box > return key 

Opens the DOS commander  
3 Optional (recommended): navigate to the directory C:\temp with 

cd c:\temp > return key  
4 At the DOS prompt enter: telnet > return key 

Starts Telnet and shows the welcome text  
5 At the DOS prompt (Microsoft Telnet) enter the IP address of the TX-I/O BIM:  

open xxx.xxx.xxx.xxx > return key 
Refreshes the screen and displays the login prompt  

6 At the DOS prompt (login:) enter: telnet > return key  
7 At the DOS prompt (password:) enter (hidden text input): user01 > return key 

Displays 'Welcome user' and prompts with PNBIM>  
 

1 At the DOS prompt (PNBIM>) enter: devicestop > return key 
Displays 'Stopping PNIO Device'  

2 At the DOS prompt (PNBIM>) enter: fwupdate pnbim_fw_Vx_x_x.bin > return 
key 
Displays 'Firmware update command received. New file : 
pnbim_fw_V0_2_18.bin' (see screenshot example below) 

Numbers are represented by an 'x' in these instructions. The 'x' can have 1 
or more digits.  

3 After the actual FW update has (automatically) run, the utility restarts the TX-
I/O BIM.   

4 At the DOS prompt (PNBIM>) enter: quit 
This exits the utility. 

 

 
 
 
 

Preparation 

Step-by-step procedure 
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6.2 Configurations Update 
 

GSDML files contain the engineering data of a Profinet device. The files are 
compiled by a Profinet device engineering tool – e.g., by the SIMATIC Manager 
hardware configuration software.  
The hardware configuration software itself has no upgrade function to upgrade, for 
example, existing configurations into a new GSDML file.  
 
 

6.2.1 Preparation 
 

Proceed as follows in order to prevent complete reengineering: 
 
1 Back up the engineering data: 

SIMATIC Manager: File > context menu: Archive > OK  
2 Read the release notes on the GSDML file to determine in what (sub)modules 

data was changed.   
3 Delete all (sub)modules with changes from the HW configuration: 

Rightclick the module row > context menu: Delete > security prompt: Yes 
button 
Hold down the CTRL key for multiselection.  

4 Export the hardware configuration engineering data to a Config file:  
HW configurator: Station > Export > text box: enter path/filename > Save 
button 

 

 
 
 

6.2.2 Updating the SIMATIC Manager 
 

Requirement: the corresponding file has already been imported. For details, 
refer to page 17 –  Import GSDML and BMP files 
 
1 S7 Manager: Run the hardware configuration   
2 Tools > Install GSD Files 

Opens Install GSD Files 
 

  

General 

Important  

Install new GSDML file 
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3 Select the required GSDML file 
The possible files are listed in the text field.  

4 Select the required File > click Install > answer security queries (click Yes)  
5 Acknowledge the installation success message (click OK) and close the 

dialog box (click Close). 
 
1. Mark the Profinet BIM > Edit > Object Properties  

Opens the Properties dialog box for the corresponding Profinet BIM  
2. Properties dialog box: click Change output status 

Opens the listbox GSD file – Change output status  
3. From the listbox, select the required (latest) file  
4. Optional: make your selection in the Use marked output status for group field 

(default: the current I/O device)  
5. Note the names of the old and new GSDML files. 

These file names will be needed later!  
6. Click the OK button. 

Closes the listbox.  
7. Properties dialog box: click OK. 
  
1. S7 hardware configurator: mark Profinet BIM > Station > Save  
2. Optional: If other BIMs are available for updating, repeat steps 3 to 10 above. 
 
 

6.2.3 Updating Export Data 
 

1. Open the exported configuration file in a text editor (Notepad, XML editor, etc.)   
2. Replace the old file names by the new GSDML file names. 

This is most easily done by Search & Replace. 
 

  
3. Save the configuration file   
4. Update the S7 hardware configuration 

Refer to the next section for details. 
 
 

Change the output 
status 

Save the update 
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6.2.4 Updating the S7 Hardware Configuration 
 

It is assumed that the reader knows of the procedure implemented above. The 
following steps are therefore repeated in concise form.  
 
1 Start the S7 hardware configurator (if this is not already the case)  
2 Station > Import 

Opens the Import dialog box.  
3 Import dialog box: mark the modified GSDML file > click Open 
 

  
4 Answer various security queries accordingly. 

Example:  

  
Two options of acknowledgement are possible: 
Yes Acknowledgement for one object (i.e., a security prompt will be 

displayed for the next object). 
All Acknowledgement for each category of objects; in this way, for 

example, all racks, all subsystems etc. can be handled with one 
security query in each case.  

5 Reply to the security query by clicking Yes.  

  
The data is then saved and the dialog box closes.   

 
6 Reengineer all previously removed modules and submodules. 

These are modules and submodules that were previously removed from the 
HW configuration because they had been changed.  

7 Station > Save and compile 
This action saves and compiles the module and submodule data.  

8 Target system > load to module  
Opens the 'Select target module' dialog box  

9 Select target module > click OK 
Follow the dialog; the action ends after a short time. 

 

Requirements 

Step-by-step procedure 
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7 Module Data 
 

This section explains how the input/output channels of the TX-I/O modules are 
mapped to the SIMATIC S7 input/output addresses.  
 
 

7.1 General 
 

Every newly added ('plugged') module must be addressed. This procedure is not 
similar for all modules. We distinguish between 
 binary input/output modules and 
 analog and multistate modules. 
 
The addressing takes place on the module (subslot 1) according to the binary 
channel of the module.  
 
The SIMATIC S7 address of a binary input/output is obtained from the 
parameterized address of the module plus the offset specified in the table. 
 
Example 
 
Module input address  50 
Channel 4 0.3 (byte 0, bit 3) 
SIMATIC S7 address E 50.3  
 
The addressing takes place on the submodule (subslots 2…1) according to the 
analog or multistate function. 
 
The SIMATIC S7 address of the analog/multistate input/output is obtained directly 
from the subslot address parameterized in the channel.  
The offsets specified in the tables are also assigned. 
 
Example 
 
Submodule input address  26  
SIMATIC S7 address PEW 26  
 
 
The SIMATIC addresses of the channel process data are given below.  

Local override information is indicated separately for each individual TX-I/O 
module. 
 
 
 

Binary modules 

Analog and multistate 
modules 
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7.2 TXM1.8D 
 

8-channel digital input module 
 
 Binary input (static) 
 Binary input (pulsed) 
 Counter input 
 
 

7.2.1 Process Data Channel Mapping 
 

BI channel Offset to input 
address 

Channel 1 Subslot 1 Byte 0 Bit 0 

Channel 2 Subslot 1 Byte 0 Bit 1 

Channel 3 Subslot 1 Byte 0  Bit 2 

Channel 4 Subslot 1  Byte 0  Bit 3 

Channel 5 Subslot 1  Byte 0  Bit 4 

Channel 6 Subslot 1 Byte 0  Bit 5 

Channel 7 Subslot 1 Byte 0  Bit 6 

Channel 8 Subslot 1 Byte 0  Bit 7 

 
CI channel Offset to input address 

Channel 1 Subslot 2 Byte 3 Byte 2 Byte 1 Byte 0 

Channel 2 Subslot 3 Byte 3 Byte 2 Byte 1 Byte 0 

Channel 3 Subslot 4 Byte 3 Byte 2 Byte 1 Byte 0 

Channel 4 Subslot 5  Byte 3 Byte 2 Byte 1 Byte 0 

Channel 5 Subslot 6  Byte 3 Byte 2 Byte 1 Byte 0 

Channel 6 Subslot 7 Byte 3 Byte 2 Byte 1 Byte 0 

Channel 7 Subslot 8 Byte 3 Byte 2 Byte 1 Byte 0 

Channel 8 Subslot 9 Byte 3 Byte 2 Byte 1 Byte 0 

 
 

7.2.2 Counter Value Default Channel Mapping 
 

The table below shows the counter value set command value assignment of the CI-
configured channels.  
The command is triggered by setting the relevant bit from 0 to 1. It sets the 
[NewCIValue] parameter to the counter value.  
 
CI channel Offset to input 

address 

Channel 1 Subslot 2  Byte 0 Bit 0  

Channel 2 Subslot 3 Byte 0 Bit 0 

Channel 3 Subslot 4 Byte 0 Bit 0 

Channel 4 Subslot 5  Byte 0 Bit 0 

Channel 5 Subslot 6  Byte 0 Bit 0 

Channel 6 Subslot 7 Byte 0 Bit 0 

Channel 7 Subslot 8 Byte 0 Bit 0 

Channel 8 Subslot 9 Byte 0 Bit 0 

 

Designation 

Supported functions 

BI – channels 
configured as binary 
input  

CI – channels 
configured as counter 
input 

CI – channels 
configured as counter 
input 
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7.3 TXM1.16D 
7.3.1 Process Data Channel Mapping 
 

16-channel digital input module 
 
 Binary input (static) 
 Binary input (pulsed) 
 Counter input 
 
BI channel Offset to input 

address 

Channel 1 Subslot 1 Bit 0 Byte 0 

Channel 2 Subslot 1 Bit 1 Byte 0 

Channel 3 Subslot 1 Bit 2 Byte 0  

Channel 4 Subslot 1 Bit 3 Byte 0  

Channel 5 Subslot 1 Bit 4 Byte 0  

Channel 6 Subslot 1 Bit 5 Byte 0  

Channel 7 Subslot 1 Bit 6 Byte 0  

Channel 8 Subslot 1 Bit 7 Byte 0  

Channel 9 Subslot 1 Bit 0 Byte 1 

Channel 10 Subslot 1 Bit 1 Byte 1 

Channel 11 Subslot 1 Bit 2 Byte 1  

Channel 12 Subslot 1 Bit 3 Byte 1  

Channel 13 Subslot 1 Bit 4 Byte 1  

Channel 14 Subslot 1 Bit 5 Byte 1  

Channel 15 Subslot 1 Bit 6 Byte 1  

Channel 16 Subslot 1 Bit 7 Byte 1  

 
CI channel Offset to input address 

Channel 1 Subslot 2 Byte 3 Byte 2 Byte 1 Byte 0 

Channel 2 Subslot 3 Byte 3 Byte 2 Byte 1 Byte 0 

Channel 3 Subslot 4 Byte 3 Byte 2 Byte 1 Byte 0 

Channel 4 Subslot 5  Byte 3 Byte 2 Byte 1 Byte 0 

Channel 5 Subslot 6  Byte 3 Byte 2 Byte 1 Byte 0 

Channel 6 Subslot 7 Byte 3 Byte 2 Byte 1 Byte 0 

Channel 7 Subslot 8 Byte 3 Byte 2 Byte 1 Byte 0 

Channel 8 Subslot 9 Byte 3 Byte 2 Byte 1 Byte 0 

Channel 9 Subslot 10 Byte 3 Byte 2 Byte 1 Byte 0 

Channel 10 Subslot 11 Byte 3 Byte 2 Byte 1 Byte 0 

Channel 11 Subslot 12 Byte 3 Byte 2 Byte 1 Byte 0 

Channel 12 Subslot 13 Byte 3 Byte 2 Byte 1 Byte 0 

Channel 13 Subslot 14 Byte 3 Byte 2 Byte 1 Byte 0 

Channel 14 Subslot 15 Byte 3 Byte 2 Byte 1 Byte 0 

Channel 15 Subslot 16 Byte 3 Byte 2 Byte 1 Byte 0 

Channel 16 Subslot 17 Byte 3 Byte 2 Byte 1 Byte 0 

 
 

Designation 

Supported functions 

BI – channels 
configured as binary 
input  

CI – channels 
configured as counter 
input 
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7.3.2 Counter Value Default Channel Mapping 
 

CI channel Offset to output 
address 

  

Channel 1 Subslot 2 Byte 0 Bit 0   

Channel 2 Subslot 3 Byte 0 Bit 0  

Channel 3 Subslot 4 Byte 0 Bit 0  

Channel 4 Subslot 5  Byte 0 Bit 0  

Channel 5 Subslot 6  Byte 0 Bit 0  

Channel 6 Subslot 7 Byte 0 Bit 0  

Channel 7 Subslot 8 Byte 0 Bit 0  

Channel 8 Subslot 9 Byte 0 Bit 0  

Only channels 1-8 can be used in this module 
for CI configurations. 

Channel 9 Subslot 10 Byte 0 Bit 0   

Channel 10 Subslot 11 Byte 0 Bit 0  

Channel 11 Subslot 12 Byte 0 Bit 0  

Channel 12 Subslot 13 Byte 0 Bit 0  

Channel 13 Subslot 14 Byte 0 Bit 0  

Channel 14 Subslot 15 Byte 0 Bit 0  

Channel 15 Subslot 16 Byte 0 Bit 0  

Channel 16 Subslot 17 Byte 0 Bit 0  

 

 
 

7.4 TXM1.8U, TXM1.8U-ML  
TXM1.8X, TXM1.8X-ML  

 

TXM1.8U  : 8-channel Universal module 
TXM1.8U-ML : 8-channel Universal module with local override and LCD 
 
AI_NI1K AI_PT1K385 AO_U10N 

AI_NTC100K AI_R2K5 BI_STATIC 

AI_NTC10K AI_T1 BI_PULSE 

AI_PT1K375 AI_U10N CI 

 
TXM1.8X : 8-channel Super Universal module 
TXM1.8X-ML : 8-channel Super Universal module with local override  
   and LCD 
 
AI_NI1K AI_R2K5 AO_U10N 

AI_NTC100K AI_T1 BI_STATIC 

AI_NTC10K AI_I020 BI_PULSE 

AI_PT1K375 AI_420N CI 

AI_PT1K385 AI_U10N  

 
 

7.4.1 Process Data Channel Mapping 
 

BI channel Offset to input 
address 

Channel 1 Subslot 1 Byte 0 Bit 0 

Channel 2 Subslot 1 Byte 0 Bit 1 

Channel 3 Subslot 1 Byte 0  Bit 2 

Channel 4 Subslot 1  Byte 0  Bit 3 

Channel 5 Subslot 1  Byte 0  Bit 4 

Channel 6 Subslot 1 Byte 0  Bit 5 

CI – channels 
configured as counter 
input 

Designation 

Supported functions 

Designation 

Supported functions 

BI – channels 
configured as binary 
input  
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Channel 7 Subslot 1 Byte 0  Bit 6 

Channel 8 Subslot 1 Byte 0  Bit 7 

 
CI channel Offset to input address 

Channel 1 Subslot 2 Byte 3 Byte 2 Byte 1 Byte 0 

Channel 2 Subslot 3 Byte 3 Byte 2 Byte 1 Byte 0 

Channel 3 Subslot 4 Byte 3 Byte 2 Byte 1 Byte 0 

Channel 4 Subslot 5  Byte 3 Byte 2 Byte 1 Byte 0 

Channel 5 Subslot 6  Byte 3 Byte 2 Byte 1 Byte 0 

Channel 6 Subslot 7 Byte 3 Byte 2 Byte 1 Byte 0 

Channel 7 Subslot 8 Byte 3 Byte 2 Byte 1 Byte 0 

Channel 8 Subslot 9 Byte 3 Byte 2 Byte 1 Byte 0 

 
AI channel Offset to input 

address 

Channel 1 Subslot 2 Byte 1 Byte 0 

Channel 2 Subslot 3 Byte 1 Byte 0 

Channel 3 Subslot 4 Byte 1 Byte 0 

Channel 4 Subslot 5  Byte 1 Byte 0 

Channel 5 Subslot 6  Byte 1 Byte 0 

Channel 6 Subslot 7 Byte 1 Byte 0 

Channel 7 Subslot 8 Byte 1 Byte 0 

Channel 8 Subslot 9 Byte 1 Byte 0 

 
 
AO channel Offset to output 

address 
 

Channel 1 Subslot 2 Byte 1 Byte 0  

Channel 2 Subslot 3 Byte 1 Byte 0  

Channel 3 Subslot 4 Byte 1 Byte 0  

Channel 4 Subslot 5  Byte 1 Byte 0  

 

Channel 5 Subslot 6  Byte 1 Byte 0  

Channel 6 Subslot 7 Byte 1 Byte 0  

Channel 7 Subslot 8 Byte 1 Byte 0  

Channel 8 Subslot 9 Byte 1 Byte 0  

Note 

Only the channels 5 – 8 can be used for the 
signal type Y420 (SIMATIC: AO_I420N).  

 
 

7.4.2 Local Override Channel Mapping 
 

AO channel Offset to output 
address 

Channel 1 Subslot 2 Byte 1 Byte 0 

Channel 2 Subslot 3 Byte 1 Byte 0 

Channel 3 Subslot 4 Byte 1 Byte 0 

Channel 4 Subslot 5  Byte 1 Byte 0 

Channel 5 Subslot 6  Byte 1 Byte 0 

Channel 6 Subslot 7 Byte 1 Byte 0 

Channel 7 Subslot 8 Byte 1 Byte 0 

Channel 8 Subslot 9 Byte 1 Byte 0 

 
 

CI – channels 
configured as counter 
input 

AI – channels 
configured as analog 
input 

AO – channels 
configured as analog 
output 

AO – channels 
configured as analog 
output 
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7.4.3 Counter Value Default Channel Mapping 
 

CI channel Offset to input 
address 

Channel 1 Subslot 2 Byte 0 Bit 0 

Channel 2 Subslot 3 Byte 0 Bit 0 

Channel 3 Subslot 4 Byte 0  Bit 0 

Channel 4 Subslot 5  Byte 0  Bit 0 

Channel 5 Subslot 6  Byte 0  Bit 0 

Channel 6 Subslot 7 Byte 0  Bit 0 

Channel 7 Subslot 8 Byte 0  Bit 0 

Channel 8 Subslot 9 Byte 0  Bit 0 

 
 

CI – channels 
configured as counter 
input 
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7.5 TXM1.6R, TXM1.6R-M, TXM1.6RL  
 

TXM1.6R  : Relay module 
TXM1.6R-M  : Relay module with local override  
 
AO_Y250T_2Cha Mo_2Pulse_6Cha Mo_Map_4Cha 

BO_Q250 BO_Q250_P Mo_Map_5Cha 

Mo_2Pulse_3Cha BO_Q250_P_2Cha Mo_Map_6Cha 

Mo_2Pulse_4Cha Mo_Map_2Cha  

Mo_2Pulse_5Cha Mo_Map_3Cha  

 
TXM1.6RL  : Light module 
 
BO_Bistabil 

 
 

7.5.1 Process Data Channel Mapping 
 

BO channel Offset to output 
address 

Channel 1 Subslot 1 Byte 0 Bit 0 

Channel 2 Subslot 1 Byte 0 Bit 1 

Channel 3 Subslot 1 Byte 0  Bit 2 

Channel 4 Subslot 1  Byte 0  Bit 3 

Channel 5 Subslot 1  Byte 0  Bit 4 

Channel 6 Subslot 1 Byte 0  Bit 5 

Channel 7 Subslot 1 Byte 0  Bit 6 

Channel 8 Subslot 1 Byte 0  Bit 7 

 
The following table shows the configured channels' process data allocation of the 
MO-configured channels.  
 
 

The first n channels apply to the n-channel MO function. 
 
Example 
The following values apply to the function Mo_Map_4Cha:  
'None', 'Channel 1', 'Channel 2', 'Channel 3', 'Channel 4'. 
 

The MO channel 1 begins with the channel number of the MO-configured submodule.  
 
Example 
The following MO channel mapping applies to the function Mo_Map_4Cha in the 
Subslot 4: 
 
MO channel 1: Channel 3 MO channel 3: Channel 5 

MO channel 2: Channel 4 MO channel 4: Channel 6 

 
Module channels are configured with a mapping function by assigning the 
MO_Map_xCha function to the start channel of the function.  
 
The mapping type is selected in the [MappingKind] parameter of the function.  
Three (3) different mapping types are provided: 
 Mapping_1_n 
 Mapping_UpDown 
 Mapping_Binary 

Designation 

Supported functions 

Designation 

Supported functions 

BO – channels 
configured as binary 
output 

MO – channels 
configured as 
multioutput (static) 

Note 

Mapping function 

Mapping type 
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The mapping types differ in their activation/deactivation of the channel outputs. 
Only the values shown in the table below are valid for this mapping type. Other 

values cause an 'invalid value' diagnostics alarm.  
SIMATIC value Channel 

number Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0 

No channel 0 0 0 0 0 0 

MO channel 1 0 0 0 0 0 1 

MO channel 2 0 0 0 0 1 0 

MO channel 3 0 0 0 1 0 0 

MO channel 4 0 0 1 0 0 0 

MO channel 5 0 1 0 0 0 0 

MO channel 6 1 0 0 0 0 0 

 
Only the values shown in the table below are valid for this mapping type. Other 

values cause an 'invalid value' diagnostics alarm.  
SIMATIC value 

Channel number 
Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0 

No channel 0 0 0 0 0 0 

MO channel 1 0 0 0 0 0 1 

MO channel 1,2 0 0 0 0 1 1 

MO channel 1,2,3 0 0 0 1 1 1 

MO channel 1,2,3,4 0 0 1 1 1 1 

MO channel 1,2,3,4,5 0 1 1 1 1 1 

MO channel 1,2,3,4,5,6 1 1 1 1 1 1 

 
Only some of the values possible for binary mapping are listed for this mapping 

type in the table below. All MO channel combinations are valid.   
SIMATIC value Channel 

number Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0 

No channel 0 0 0 0 0 0 

MO channel 1 0 0 0 0 0 1 

MO channel 2 0 0 0 0 1 0 

MO channel 3 0 0 0 1 0 0 

MO channel 4 0 0 1 0 0 0 

MO channel 5 0 1 0 0 0 0 

MO channel 6 1 0 0 0 0 0 

MO channel 1,2 0 0 0 0 1 1 

MO channel 1,3 0 0 0 1 0 1 

MO channel 1,4 0 0 1 0 0 1 

MO channel 1,5 0 1 0 0 0 1 

MO channel 1,6 1 0 0 0 0 1 

 
Only the values shown in the table below are valid for the 'pulse' function type. 

Other values cause an 'invalid value' diagnostics alarm.    
SIMATIC value 

Pulse 
Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0 

No channel 0 0 0 0 0 0 

MO channel 1 0 0 0 0 0 1 

MO channel 2 0 0 0 0 1 0 

MO channel 3 0 0 0 1 0 0 

MO channel 4 0 0 1 0 0 0 

MO channel 5 0 1 0 0 0 0 

MO channel 6 1 0 0 0 0 0 

1:n mapping 

UpDown mapping 

Binary mapping 

MO – multioutput 
pulse-configured 
channels 
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AO channel Offset to output 
address 

Channel 1 Subslot 2 Byte 1 Byte 0 

Channel 2 Subslot 3 Byte 1 Byte 0 

Channel 3 Subslot 4 Byte 1 Byte 0 

Channel 4 Subslot 5  Byte 1 Byte 0 

Channel 5 Subslot 6  Byte 1 Byte 0 

Channel 6 Subslot 7 Byte 1 Byte 0 

Channel 7 Subslot 8 Byte 1 Byte 0 

Channel 8 Subslot 9 Byte 1 Byte 0 

 
 

7.5.2 Local Override Channel Mapping 
 

BO, AO, MO channel Offset to input 
address 

  

Channel 1 Subslot 1 Byte 0 Bit 0  

Channel 2 Subslot 1 Byte 0 Bit 1  

Channel 3 Subslot 1 Byte 0  Bit 2  

Channel 4 Subslot 1  Byte 0  Bit 3  

Channel 5 Subslot 1  Byte 0  Bit 4  

Channel 6 Subslot 1 Byte 0  Bit 5  

Channel 7 Subslot 1 Byte 0  Bit 6  

Channel 8 Subslot 1 Byte 0  Bit 7  

The last bit (bit 0–7) in each case is responsible 
for the mode (active/inactive) of the local override 
function. For details, refer to the appropriate local 
override mode parts in Section 4 – Parameters. 

 
 

7.6 TXM1.8P  
 

TXM8P  : PT100 module 
 
AI_NI1K AI_PT1K375 

AI_PT100_4_Climatic AI_R250 

AI_PT100_4_Climatic AI_R2K5 

 
 

7.6.1 Channel Process Data Channel Mapping 
 

The table below shows the AI-configured channels. 
 
AI channel Offset to input 

address 

Channel 1 Subslot 2 Byte 1 Byte 0 

Channel 2 Subslot 3 Byte 1 Byte 0 

Channel 3 Subslot 4 Byte 1 Byte 0 

Channel 4 Subslot 5  Byte 1 Byte 0 

Channel 5 Subslot 6  Byte 1 Byte 0 

Channel 6 Subslot 7 Byte 1 Byte 0 

Channel 7 Subslot 8 Byte 1 Byte 0 

Channel 8 Subslot 9 Byte 1 Byte 0 

 

AO – analog output-
configured channels 

BO-, AO-, MO-
configured channels 

Designation 

Supported functions 

AI – analog input-
configured channels 
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7.6.2 Local Override Channel Mapping 
 

The table below shows the channel mapping of local override information of AO-
configured channels. 
 
AO channel Offset to input 

address 
 

Channel 1 Subslot 2 Byte 0 Bit 0 

Channel 2 Subslot 3 Byte 0 Bit 0 

Channel 3 Subslot 4 Byte 0 Bit 0 

Channel 4 Subslot 5  Byte 0 Bit 0 

Channel 5 Subslot 6  Byte 0 Bit 0 

Channel 6 Subslot 7 Byte 0 Bit 0 

Channel 7 Subslot 8 Byte 0 Bit 0 

Channel 8 Subslot 9 Byte 0 Bit 0 

 

The last bit (bit 0–7) in each case is responsible 
for the mode (active/inactive) of the local override 
function. For details, refer to the appropriate local 
override mode parts in Section 4 – Parameters. 

 

AO – analog output-
configured channels 
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8 Hardware 
8.1 Installing the Devices  
 

 This is an overview of the most important steps in the installation and 
replacement of the devices. Further information (e.g., dimensioning, bus extension, 
etc.) can be found in the corresponding installation manual.  

Start the installation in all cases with one or two 'A' devices that provide the bus 
signal, the module power supply and the field power supply (e.g., a power supply 
module). 
 

 

N1 BIM (Bus Interface Modul) 
without integrated power 
supply 

U1 Power supply module 
TXS1.12F10 

X1 Bus interface module 
TXS1.EF10 

 
Install each I/O row from left to right (or from top to bottom). Install the devices 

in an upright position in succession on the standard mounting rail.  
The island bus constructs itself as a result. 
 
1. Start the installation in all cases with one or two 'A' devices that provide the 

bus signal, the module power supply and the field power supply (e.g., a power 
supply module). 
– Pull out the mounting slider (1)  
– Press the device onto the rail (2) 
– Slide in the mounting slider (3)   

2. Insert the I/O modules in succession on (4), (5). 
 

1
07

62
J0

17

1

2

3 5
4

  
3. Optional: Add additional bus interface modules between the modules and no 

more than one further power supply module ('A') for each I/O row.  

Note 

Procedure 
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8.2 Replacing a Module 
 

An electronic unit can be replaced at any time by a similar or compatible type, 
even if the system is in operation. 
 
When replacing a whole module (including socket), the following points must be 
observed:  
 The bus connector protrudes from all TX-I/O devices on the right. For this 

reason, the electronic unit must first be removed from the neighboring module 
on the right.  

 The removal of the terminal socket interrupts the island bus so that modules on 
the right no longer receive power. 

 
To replace the module U (including socket) with the number n: 
 
1. First swivel out the address key at the neighboring module Un+1 (1)  
2. Remove the electronic unit Un+1 (2)  
3. Remove the mounting slider at the terminal socket Un (3)  
4. Remove the whole module Un with the terminal socket (4)  
5. Install the new module Un with terminal socket – without an address key  
6. Push in the mounting slider Un   
7. Insert the address key of the old module in the new module and swivel it into 

position carefully  
8. Insert the electronic unit at the neighboring module Un+1 again and carefully 

swivel the address key into position. 
 

Un 1

Un 1

Un

1
07

62
J0

18

2

1

4

3

 
 

Once the new electronic unit has a connection with the bus master, it is 
configured in accordance with the module address and begins to work after a 
brief period of time. 

 
If you need a previously used electronic unit or used module as the replacement 
part, it must be reset to the factory settings with the deletion key before the 
address key is permitted to be swiveled into place.  
 
 The same procedure is used as for replacing an I/O module. 
 These devices have pluggable terminals for fast connection.  
 
 
 

Electronic unit 

Module including 
socket 

Procedure 

Note  

BIM, power supply 
module, bus interface 
module 
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8.3 Labeling and Addressing Devices  
8.3.1 Flow and Allocation of the Labelling 
 

Depending on the project work flow and organization of the goods flow, the labels 
– are supplied with the devices to install or 
– are used when taking them into commission at the system site. 
 
 

8.3.2 Labeling the I/O Modules 
 

The information applied at the following positions is used for unique identification of 
each I/O module and its connections:   
 Module front 

– Module type and symbols for the display and control elements 
– Insertable label, can be freely labeled 

 
 Address key 

– Address numbers from 1...120 
 
The insertable labels for the I/O modules can be freely labeled.   

 A4 sheets with the corresponding divisions and perforations can be ordered 
under the order number TXA1.LA4.  

 
These sheets can be printed with the easy-to-use Excel file IoLabel.xls.  
 
The module address and the function of each I/O point can be printed on the labels 
created in this way. 
A function is integrated into the TX-I/O tool that enables the label sheets to be 
automatically printed in accordance with the generated module assignment. 
 
The connection terminals have only general names since the I/O points can have 
different functions. 
 
 The electronic unit has a removable transparent cover (label holder) into which 

the label can be inserted (A, C).  
 The modules can also be operated without this 'cover' (B). 
  

A 
Inserting the label 

B 
Removing the cover 

Assembly 

2

81
7

2z
11

1

 

 

10
56

2
J0

63

 

 

 

 
 

Different flows 

Labeling positions 

Labels 

Connection terminals 

Inserting the labels 
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8.3.3 Addressing 
 

 In order for the automation station to be able to identify and address a specific 
I/O module, each I/O module needs its own address.  

 Without an address key, the module is in a secure, inactive state.  
 The module is fully functional with the address key.  
 The module address is mechanically coded in the address key. It is inserted in 

the I/O module socket and swiveled into the electronic unit.  
 Based on the address, the module is configured by the bus master via the island 

bus and in this way receives the information as to what peripheral devices are 
connected and what function is required for the periphery.  

 If the electronic unit is replaced, the address key must first be swiveled out.   
 The load is disabled as a result. The values remain stored in the bus master. 

The key is left inserted in the terminal socket so that the bus master can inform 
the new electronic unit of its function. 

 
If you need a previously used electronic unit or used module as the replacement 
part, it must be reset to the factory settings with the deletion key before the 
address key is permitted to be swiveled into place.  
 
The address key must first be firmly inserted in the terminal socket and then 
carefully swiveled into the electronic part. 
 

1
0

56
2

J0
61

1

 

2 10
56

2
J0

62

 

 
 
 
 

Note  
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8.4 Technical Data 
 

Parameter Type Value 

Power supply (6, 7) Operating voltage AC / DC 24 V 

 Frequency 50 / 60 Hz 

Power consumption Without loading by modules and field devices 3 VA, corresponding to 25 kWh/a  

   

Island bus Island bus connector TX-I/O-compatible 

   

Profinet (1, 2) 2 x RJ45 (switch) 10 / 100 Mbit/s 

   

Connection terminals, pluggable Construction type 

Cu-wire or Cu-strand with wire end sleeve 

 

Cu-strand without wire end sleeve 

Pluggable screw terminals 

1 x 0.6 mm to 2.5 mm2 

or 2 x 0.6 mm to 1.0 mm2 

1 x 0.6 mm to 2.5 mm2 

or 2 x 0.6 mm to 1.5 mm2 

 Screwdriver Slot screws  
Screwdriver, size 1  
with shaft ø ≤ 4.5 mm 

 Max. tightening torque 0.6 Nm 

   

Assignment as per EN 60730 Operation of automatic controller 

Level of contamination  

Construction type 

Type 1 
2 

Protection class III 

   

Housing protection type Protection type as per EN 60529 
Front parts in the DIN section 
Terminal part 

 
IP30 
IP20 

   

Environmental conditions Operation According to IEC 60721-3-3 

 Climatic conditions Class 3K5 

 Temperature –5 ... 50 °C 

 Relative humidity 5 ... 95 % r.H. 

 Mechanical conditions Class 3M2 

 Transport According to IEC 60721-3-2 

 Climatic conditions Class 2K3 

 Temperature –25 ... 70 °C 

 Relative humidity 5 ... 95 % r.H. 

 Mechanical conditions Class 2M2 
   

Standards and guidelines Product security  

 Automatic electronic controllers for household 
use and similar applications 

EN 60730-1 

 Electromagnetic compatibility  

 Noise immunity Industrial environment EN 61000-6-2 

 Emitted interference Residential 
environment,  light industry 

EN 61000-6-3 

 CE conformance  

 EMC guidelines 2004/108/EG 

 c-Tick conformance  

 Australian EMC framework radio emission AS/NZS 61000-6-3 

 UL-Approbation  
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Parameter Type Value 

 Energy management equipment UL 916 (PAZX) 

   

Environmental compatibility Product environmental declaration CM1E8186 
contains data for environmental-compatible product 
design and evaluation (RoHS conformance, 
material composition, packaging, environmental 
benefits, disposal) 

ISO 14001 (environment) 
ISO 9001 (quality) 
SN 36350 (environmental-compatible products) 
2002/95/EG (RoHS) 

   

Color Housing RAL 7035 (light-gray) 
   

Dimensions See dimension images  

 Width in DIN pitch units 7.5 

   

Weight Including packaging 0.201 kg 
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8.5 Connections 
 

  

 
 

 

 

 

 

 

 

 

 

 

 

 Face view 

 

 

 

 

 

 

 

 

 

 

 
 

 
 
 Top view 

 
Power supply 
G 6, 7 AC / DC 24 V 

   

PROFINET 1, 2 2 x RJ45 (switch) 

   

RUN  Firmware / hardware status (in connection with FLT)1) 
FLT  Firmware / hardware status (in connection with RUN)1) 
LINK1  Connection Ethernet port 11) 
COM1  Communication Ethernet port 11) 
LINK2  Connection Ethernet port 21) 
COM2  Communication Ethernet port 11) 
  1) For details on the LEDs, refer to 5.2 – Diagnostics on the TX-I/O BIM 
   

 
1 GND 5 VPP 
2 RxD 6 CHM 
3 not assigned 7 BTL 
4 TxD 8 GND 
    

12 3 4 5678

     

 
Note  

The PROFINET BIM must not be connected with either a hub, a router, or a non 
real-time switch! 
Always connect the PROFINET BIM with either a S7 CPU, a S7 CP, or a real-time 
switch!

PROFINET BIM connection 
 
Status LEDs 

RJ45 pin assignment 
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